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About this book

This book provides instructions for installing and using IBM® Software Configuration 
and Library Manager (SCLM) Suite Administrator Workbench.

This book is designed to help SCLM project administrators and installation personnel 
perform these tasks:

• Define new SCLM projects and modify existing projects

• Perform required SCLM language and architecture definitions; maintain VSAM 
files, and import software assets into an SCLM project

• Maintain IBM Enhanced Access Control for SCLM for z/OS® data set profiles, 
profile access files, settings, and applications

• List and review Enhanced Access Control for SCLM violations

• Diagnose and recover from SCLM Suite Administrator Workbench problems

• Use SCLM Suite Administrator Workbench with other products comprising IBM’s 
SCLM Suite.

Always check the SCLM Suite Administrator Workbench Library page for the most 
current version of this publication:  

http://www-3.ibm.com/software/awdtools/sclmsuite/sclm/library

This book is a companion to the IBM SCLM Suite Administrator Workbench: 
Installation and Customization Guide, GC31-6787.  See that manual for information 
about installing and configuring SCLM Suite Administrator Workbench. 

Who should read this book

This book is intended for those persons responsible for installing and customizing 
SCLM Suite Administrator Workbench and assumes a working knowledge of:

• The z/OS operating system

• IBM WebSphere® Studio Workbench

• ISPF

• SCLM

• SMP/E

• RACF®, for those users that will administer Enhanced Access Control for SCLM 
for z/OS

Conventions used in this book

This book uses the following highlighting conventions:

• Boldface type indicates commands or user interface controls such as names of 
fields, folder, icons, or menu choices.

• Monospace type indicates examples of text that you enter exactly as shown.

• Italic type indicates variables that you should replace with a value. It is also used 
to indicate book titles and to emphasize significant words.

The following labels identify significant elements within this book:

• Definition: is used to identify and define terminology unique to this product.
© Copyright IBM Corp.  2003, 2004  v
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• Example: is used to identify example code or scenarios.

• In this chapter: is used to identify the significant subsections within each chapter.

• Recommendation: is used to provide guidance when more than one option is 
available.

• Related reading: is used to refer you to other publications that contain relevant 
information.

• Restriction: is used to identify a restriction or limitation with this product or an 
associated procedure.

Terminology used in this book

In this book, Software Configuration and Library Manager (SCLM) Suite 
Administrator Workbench is referred to as “SCLM Suite Administrator Workbench.”  
IBM Enhanced Access Control for SCLM for z/OS is referred to as "Enhanced Access 
Control for SCLM," or in message text or where space is limited, simply as "EAC."   
IBM Breeze for SCLM for z/OS is referred to as "Breeze."

Service updates and support information

To find service updates and support information, including software FixPaks, PTFs, 
Frequently Asked Question (FAQs), technical notes, troubleshooting information, and 
downloads, refer to the following Web page:

http://www-3.ibm.com/software/awdtools/sclmsuite/sclm/library

Using LookAt to obtain message explanations

LookAt is an online facility that displays explanations for most messages that you 
encounter, as well as for some system abends and codes. You can access LookAt: 

• From the Internet at:

www.ibm.com/eserver/zseries/zos/bkserv/lookat/

• From anywhere in z/OS where you can access a TSO/E command line (for 
example, a TSO/E prompt, ISPF, or z/OS UNIX System Services running OMVS). 
To use LookAt as a TSO/E command, LookAt must be installed on your host 
system. Obtain the LookAt code for TSO/E from a disk on your z/OS Collection 
(SK3T-4269) or from the LookAt ftp site:

ftp.software.ibm.com/ps/products/ibmreader/tools/lookat/ZOS/

• From your Palm™ VIIx personal data assistant (PDA). To use LookAt from your 
Palm VIIx PDA, LookAt must be installed on the PDA. Obtain the LookAt code 
from a disk on your z/OS Collection (SK3T-4269) or from the LookAt ftp site:

ftp.software.ibm.com/ps/products/ibmreader/tools/lookat/PALM/

 

Where to find information

The SCLM Suite Web page and web pages for the component products of the SCLM 
Suite provide current product documentation that you can view, print, and download. 
To locate publications with the most up-to-date information, refer to the following 
Web pages:  

http://www-3.ibm.com/software/awdtools/sclmsuite/sclm/library
 vi IBM Software Configuration and Library Manager Suite Administrator Workbench: User’s Guide  
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IBM Redbooks® that cover the SCLM Suite are available from the following Web page:

http://publib-b.boulder.ibm.com/Redbooks.nsf
/Redbooks?SearchView&Query=sclm

Accessibility features

Accessibility features help a user who has a physical disability, such as restricted 
mobility or limited vision, to use a software product successfully. The major 
accessibility features in SCLM Suite Administrator Workbench enable users to:

• Use assistive technologies such as screen readers and screen magnifier software. 
Consult the assistive technology documentation for specific information when 
using it to access z/OS interfaces.

• Customize display attributes such as color, contrast, and font size.

• Operate specific or equivalent features using only the keyboard. Refer to the 
following publications for information about accessing ISPF interfaces:

— z/OS ISPF User’s Guide, Volume 1, SC34-4822

— z/OS TSO/E Primer, SA22-7787

— z/OS TSO/E User’s Guide, SA22-7794

These guides describe how to use ISPF, including the use of keyboard shortcuts or 
function keys (PF keys), include the default settings for the PF keys, and explain 
how to modify their functions.

Navigating in a workstation panel

When you use the Tab key to navigate through a workstation panel, as you move from 
field to field, one of the letters in each of the descriptions is underlined.  This provides 
a keyboard shortcut to the field in question.  This behavior does not occur when using 
the mouse to select a field on the panel.

Copying and pasting while using the workstation interface

If you want to copy information from a text field or paste information into a text field, 
place your cursor in the field in question.  To copy, select the text to be copied, right-
click in the text field, and select Copy from the pop-up menu.  To paste information 
into a text field, place your cursor into the field in question, right-click, and select 
Paste from the pop-up menu.  Currently, the use of Ctrl+C and Ctrl+V, respectively, 
are not supported in all text fields.

How to send your comments

Your feedback is important in helping to provide the most accurate and high-quality 
information. If you have any comments about this book or any other SCLM Suite 
Administrator Workbench documentation:

• Use the online reader comment form located at: 

http://www-3.ibm.com/software/awdtools/rcf/

• Send your comments by e-mail to dmtinfo@us.ibm.com. Be sure to include the 
name of the book, the part number of the book, the version of SCLM Suite 
Administrator Workbench, and, if applicable, the specific location of the text you 
are commenting on (for example, a page number or table number).

• Print and fill out the reader comment form located at the  back of this book. You 
can either give the completed form to your local IBM branch office or IBM 
   About this book  vii
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representative, or you can send it to the address printed on the  reader comment               
form.

Before you begin

Before you can begin to use SCLM Suite Administrator Workbench,   customization of 
the host component as described in the IBM SCLM Suite Administrator Workbench: 
Installation and Customization Guide must be completed.  This work normally is 
performed by an enterprise’s Systems Programmer.  To use the client workstation 
component, each workstation component must be customized as described in that 
Guide.

Summary of Changes

The SCLM Suite Administrator Workbench User’s Guide, SC31-6571-01,  contains the 
following enhancements and changes:

• The  SCLM Project Quick Menu has been added to the ISPF interface to permit 
you to move from function to function in the order you select from this menu. 

• The required level of Remote Systems Explorer is Version 6.0.3. The RSE 6.0.3 
Preference page permits you to control file cache size and clear the cache. 
However, you must not do so while an SCLM Suite Administrator Workbench 
project is open.

In this latest version of the manual, SC31-6571-02, the Language Definition Wizard 
has been enhanced to provide improved ease-of-use and additional functionality.

In addition, a number of changes have been made to the install information found in 
the SCLM Suite Administrator Workbench Installation and Customization Guide.  See 
that manual for detailed information.
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Part 1. Introduction

This part contains an overview of  IBM Software Configuration and Library Manager 
(SCLM) Suite Administrator Workbench.
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Chapter 1. About the SCLM Suite Administrator Workbench

IBM's SCLM is a program that provides software configuration and library 
management for the z/OS and OS/390® platforms. Using the SCLM Suite 
Administrator Workbench, you can address the complexity of setting up an SCLM 
project initially, performing day-to-day project maintenance, and managing access 
control from a workstation. It provides the  simplicity and functionality you need at 
an attractive cost. 

Because SCLM Suite Administrator Workbench provides both a GUI and an ISPF 
interface,  you can work in the environment in which you're most comfortable.  While  
SCLM Suite Administrator Workbench functions run primarily in the foreground, the 
product supports both batch and online execution for project creation, project cloning, 
and VSAM file maintenance.  You can choose immediate response when you require 
it, or can defer processing to a more convenient time.  You specify where these 
functions are to run from the Window pulldown by specifying Preferences > SCLM 
Admin Workbench.

You can get started easily with SCLM Suite Administrator Workbench by invoking the 
SCLM Project Wizard, either from a workstation or from an ISPF host session, to 
create a new project or modify an existing one.  When creating a new project, the 
fields in the Project Wizard will be populated with default values.  When modifying 
an existing project, the fields contain that project’s defined values.

Using the Project Wizard, you can define the elements that comprise your project.  As 
you enter data into the Project Wizard, that data is saved at the host.  Thus, at any 
time, you can choose to stop work before you have fully defined the project.  SCLM 
Suite Administrator Workbench saves your work so that you can pick it up in a later 
session.

When defining a group using the workstation interface, you can drag and drop boxes 
around your display, building a network of linked boxes much like an organization 
chart. Each box represents an SCLM group.  Once you have completed your 
definition, SCLM Suite Administrator Workbench generates default authorization 
codes and PROMOTE definitions, which you can modify if you so choose. A  process 
to add or modify groups is also available at the host using ISPF panels. 

Using the Project Wizard, you can  configure any user exits you may require, 
including the Breeze user exits, if you have installed Breeze.  You can add language 
types, or you can modify them using the Language Definition Wizard.

Other functions provided by the SCLM Suite Administrator Workbench include:

• The ability to update and run your VSAM tasks and perform VSAM file 
maintenance

• The ability to create architecture definitions manually or by importing them from 
existing JCL or an existing Load Module, guided by the Architecture Definition 
Wizard

• The ability to easily clone an existing project and, if you so desire, its data

You can update and manage SCLM projects that have not been created by SCLM Suite 
Administrator Workbench, provided that these projects use simple SCLM macros and 
the project definitions are not contained within macros as might be done, for example, 
to support conditional project construction.  
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Support for Enhanced Access Control for SCLM Administration

Enhanced Access Control for SCLM is a program that enhances RACF security.  The 
SCLM Suite Administrator Workbench assists you in administering Enhanced Access 
Control for SCLM by:

• Maintaining existing RACF Data Set Profiles,  Enhanced Access Control for SCLM 
Rules Files,  Enhanced Access Control for SCLM Profile Access Rules, and 
Enhanced Access Control for SCLM Applications

• Displaying a list of Enhanced Access Control for SCLM Violations

For additional information about the Enhanced Access Control for SCLM 
administration tasks supported by SCLM Suite Administrator Workbench, see Part 3, 
“Administering EAC,” on page 67.

Hardware and software requirements

When describing system requirements for installing and using SCLM Suite 
Administrator Workbench, the following terminology is used:

• The driving system is that system used to install the product

• The target system is that system on which the product is installed

The sections that follow provide an overview of the hardware and software 
requirements to run SCLM Suite Administrator Workbench. Current and complete 
information, including any required APARs and PTFs is found in the SCLM Suite 
Administrator Workbench Program Directory.

Hardware requirements

Required hardware is any hardware environment that supports the required software 
as described in “Software requirements”.

Software requirements

The driving system software requirements may be any one of the following:

• OS/390 V02.10.00

• z/OS V01.02.00 or later

• IBM SMP/E for z/OS and OS/390 V03.02.00 or later

The target system software requirements may be any one of the following:

• XML Toolkit for z/OS V01.04.00 or V01.06.00.

• Java V01.03.01, the May, 2003, or later revision

• Any one of the following:

— OS/390 V02.10.00

— z/OS V01.02.00 or later

— IBM SMP/E for z/OS and OS/390 V03.02.00 or later
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Part 2. Administering SCLM

This part provides  instructions for performing the tasks required to administer 
SCLM.  For information about administering IBM Enhanced Access Control for 
SCLM, see Part 3, “Administering EAC,” on page 67.

If SCLM Suite Administrator Workbench has not yet been installed and configured 
for your site, refer to the SCLM Suite Administrator Workbench Installation and 
Customization Guide for information on installing the host and workstation 
components of the product and performing the required customization.

Note:  Before you can begin to use SCLM Suite Administrator Workbench,   
customization of the host component as described in the SCLM Suite Administrator 
Workbench Installation and Customization Guide must be completed.  This work 
normally is performed by an enterprise’s systems programmer.  To use the client 
workstation component, each workstation component must be customized as 
described in that Guide.
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Chapter 2. Starting an SCLM Suite Administrator Workbench 
Session 

In order to administer your existing SCLM projects or create a new project, follow the 
directions below.  

From  the workstation

Log onto SCLM Suite Administrator Workbench and follow the steps below.  Do not 
start multiple instances of SCLM Suite Administrator Workbench simultaneously 
from the same user ID, since unpredictable results can occur. 

1. Under Windows®, log onto the product from the Start menu: Start > Programs > 
IBM SCLM Suite Administrator Workbench. Alternatively, open a DOS window 
to the directory where you have installed SCLM Suite Administrator Workbench. 
At the command prompt enter sclmawb.bat. 

2. In the UNIX® or Linux client environments, ensure you are running under the X 
Window system and the DISPLAY environment variable is set. Change directories 
to the WSWB eclipse directory by entering cd WSWB/eclipse.  From a command 
prompt, enter sclmawb.sh.

Note:  Using sclmawb.sh is the only recommended way to begin your use of 
SCLM Suite Administrator Workbench. Do not execute Eclipse. 

3. Enter your logon ID and password when prompted. The first time you use the 
product, you should place a check next to Save ID on the logon pop-up. You may 
optionally want to place a check next to Save Password, which makes it 
unnecessary to reenter your password once you have logged onto the system. If 
you have saved your ID or password and need to reset one or both:

a. From the Window pulldown, select Preferences > Remote Systems 
>Passwords.

b. From the list that displays, select the system on which you want to add, 
change, or remove password information and press OK.

4. The product typically will open in the SCLM Administration perspective.  If the 
product opens in other than the SCLM Administration perspective, switch to the 
SCLM Administration Perspective by clicking the SCLM Suite Administrator 
Workbench icon at the far left side of your workspace, or from the Window pull-
down, click Open Perspective > SCLM Admin Workbench.   A pop-up menu 
may again request your logon ID and password for the host system. When your 
logon has been accepted, your host session begins. You can now create a project or 
modify an existing project.

5. In the Remote Systems Navigator, click on the name of the host where the SCLM 
project you want to administer resides.

6. After your credentials have been validated and accepted,  SCLM Suite 
Administrator Workbench generates a list of existing SCLM projects including 
any alternate projects, and displays these in the Navigator tree. 

You can filter the list of projects presented to you. For information, see “Filtering 
objects in the Remote Systems Navigator tree” on page 8 below.

7. To create a new project, right-click on the SCLM Admin Workbench  connection 
and select New > SCLM Project from the pop-up menu.
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8. If you have previously defined a project or multiple projects, a list of these 
existing projects displays in the Navigator tree.  This may be a filtered list as 
described in item 3, above.  Each existing project displays a blue box in front of its 
name.  If the project is an incomplete project, the blue box will have a broken line 
through it.  If the project is corrupt, the blue box will display a red X in it. To work 
with an existing project, right-click that project in the Remote Systems View. 
Selecting Open Project from the pop-up menu places you in the project wizard 
for that project. 

If you have selected an existing project to work with, SCLM Suite Administrator 
Workbench displays the Reset SCLM Project dialog on which you can choose to 
reset your SCLM project.  Responding Yes to this dialog causes your project to be 
reparsed from the project source code (that is, your XML source is regenerated). 

9. You can delete or rebuild the project by right-clicking the project’s name and 
selecting the appropriate choice from the pop-up menu. To perform other tasks 
for this project, select that task from the list provided in the SCLM pull-down 
menu or pop-up menu.

Filtering objects in the Remote Systems Navigator tree 

You can filter the list of objects presented to you in the Navigator tree.  The filters you 
define are host-specific.  That is, if you create a filter on host A, that filter will apply 
only to host A and not to host B.  

When you first install SCLM Suite Administrator Workbench, the project filter is set to 
an asterisk (*).  All projects appear in your Navigator tree.  To change the filter, at any 
time you can right-click Project Filter in the Navigator Tree, then click Change in the 
pop-up menu that displays.  This causes SCLM Suite Administrator Workbench to 
display the Change System Filter menu on which you can add or change project 
filters.  You can also right-click on a filter listed in the Filter Strings list box on this 
menu to see additional options you can take against a specific filter.   

Note:  A project filter is case-sensitive.  

From an ISPF session

Note:  When you initially log onto TSO to use SCLM Suite Administrator Workbench, 
your user profile  should have been modified to specify an adequate maximum size 
for your TSO region under RACF.  Typically, this profile modification will have been 
made for you by your site’s systems programmer when setting up SCLM Suite 
Administrator Workbench. If you are using XML toolkit V1R4, your TSO maximum 
region size should be 20000. If you are using XML toolkit V1R6, your TSO maximum 
region size should be 60000.  

Log onto ISPF at the host. On the ISPF command line, type 10.8.2. The  SCLM Project 
Administration Main Menu displays. From this menu, you can enter one of the 
following options on the command line: 

1 Settings: Permits you to set default values for the project.

2 Create: Permits you to create a new SCLM project. To create a new project, 
enter the project name of up to 8 characters in length, and an alternate name, 
also of up to 8 characters, on the lines provided.  Then enter 2 in the Options 
field.

3 List: Displays a list of SCLM projects. By placing the appropriate letter on the 
line in front of a project, you can take one of the actions described in the next 
section, Actions you can take. You can filter the list of projects that SCLM 
Suite Administrator Workbench displays by using an asterisk as a wild card 
as part of the Project Name or Alternate Name field on the Main Menu.
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If you have selected an existing project to work with, SCLM Suite 
Administrator Workbench asks whether you want to reset your SCLM 
project.  Responding Yes causes your project to be reparsed from the project 
source code (that is, your XML source is regenerated) and any settings that 
have been defined are overwritten. 

X Exit: Saves your work and ends yourSCLM Suite Administrator Workbench 
session.  You can also use PF3 to perform this action. 

Note:  If you are working in ISPF split screen mode, you may not work on the same 
SCLM project in both SCLM Suite Administrator Workbench windows.

Actions you can take

Using SCLM Suite Administrator Workbench, you can:

Create a new project
SCLM Suite Administrator Workbench places you in the Project Wizard, with 
the Wizard’s panels populated with SCLM Suite Administrator Workbench’s 
default values.  See Chapter 3, “Using the Project Wizard to Create or Modify 
a Project,” on page 11.

Modify the project
SCLM Suite Administrator Workbench places you in the Project Wizard, with 
the Wizard’s panels populated with the current project definition.  See 
Chapter 3, “Using the Project Wizard to Create or Modify a Project,” on page 
11.

Create a Language Definition
SCLM Suite Administrator Workbench places you in the Language Definition 
Wizard.  See Chapter 6, “Using the Language Definition Wizard,” on page 37.

Delete the project
SCLM Suite Administrator Workbench determines whether the project or the 
project and its associated data are to be deleted and takes appropriate action.  
See Chapter 7, “Deleting a Project or Other SCLM Objects,” on page 49.

Clone the project
SCLM Suite Administrator Workbench places you in the project cloning view. 
See Chapter 8, “Cloning an Existing Project,” on page 53.

Rebuild the project
SCLM Suite Administrator Workbench reassembles and relinks the project 
definition.  If the project has alternates, these will also be rebuilt. To rebuild a 
project, complete the tasks to modify a project and select Rebuild. 

Migrate assets into the project
SCLM Suite Administrator Workbench places you in the Migration Wizard.  
See Chapter 9, “Migrating Software Assets into your Project,” on page 55.

Perform VSAM file maintenance
SCLM Suite Administrator Workbench assists you to perform VSAM file 
maintenance.  SeeChapter 10, “Maintaining the Project’s VSAM Files,” on 
page 57.

Create an Architecture Definition
SCLM Suite Administrator Workbench places you in the Architecture 
Definition Wizard.  See Chapter 11, “Using the Architecture Definition 
Wizard,” on page 59.

Reparse the project
SCLM Suite Administrator Workbench regenerates the XML code associated 
with this project. 
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Chapter 3. Using the Project Wizard to Create or Modify a 
Project

This chapter will help you get started using the SCLM Suite Administrator 
Workbench Project Wizard to create or modify a project. Before starting an SCLM 
Suite Administrator Workbench session from the workstation client or from ISPF, be 
sure you have completed the steps to install and customize the product as 
documented in the IBM SCLM Suite Administrator Workbench: Installation and 
Customization Guide.

From the workstation

If you are using the workstation interface:

1. Start your workstation session by clicking Start > All Programs > IBM SCLM  
Suite Administrator Workbench  to open the product.

2. Click the host on which you want to perform administration tasks

3. Enter your z/OS  user ID and password for that host

4. After your credentials have been validated and accepted:

• To create a new project,  from the File pull-down, select Project > New.

• To modify an existing project, click its name in the Remote Systems Explorer 
view. SCLM Suite Administrator Workbench retrieves the project’s settings 
from the host.

From an ISPF session

If you are using ISPF, you can enter option 10, followed by option 8, on successive 
ISPF panel Command lines.  This displays to you, in order: 

• The SCLM Main Menu

• The SCLM Suite Administrator Workbench Main Menu

To create a new project, on the SCLM Suite Administrator Workbench Main Menu, 
type option 2 on the Command line and press Enter.  SCLM Suite Administrator 
Workbench places you in the first panel of the Project Wizard. 

To modify an existing project, type option 3 on the Command line and press Enter. 
SCLM Suite Administrator Workbench generates and displays a list of existing SCLM 
projects from which you can select the one to modify.

To shortcut this process, type option 10.8.2 or option 10.8.3, respectively,  on the ISPF 
Command line and press  Enter to create or modify a project.  

As you enter data into the Wizard's panels, the values you enter will be saved at the 
host system, so that if you choose to end a session before completing your work, any 
definitions or modifications are saved and are available to you when you resume your 
work.
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Working with the Project Wizard

The Project Wizard guides you through the steps of defining your SCLM project. The 
chapters that follow describe using the Wizard from the workstation (Chapter 4, 
“Using the Project Wizard from the Workstation to Create or Modify a Project,” on 
page 13) or from an ISPF session (Chapter 5, “Using the Project Wizard from an ISPF 
Session to Create or Modify a Project,” on page 25). 

Note that you can perform some steps of the Wizard using the workstation and others 
using ISPF at the host system.  However, you cannot begin to define or modify a 
project using the Wizard and subsequently modify that project outside of the SCLM 
Suite Administrator Workbench, since any modifications you make outside of the 
product will be lost.
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Chapter 4. Using the Project Wizard from the Workstation to 
Create or Modify a Project

This chapter describes the use of the Project Wizard when working at a workstation 
client.  For information about using the Project Wizard from an ISPF session, see 
Chapter 5, “Using the Project Wizard from an ISPF Session to Create or Modify a 
Project,” on page 25.  

Navigating through the workstation interface

This chapter assumes that you have logged onto SCLM Suite Administrator 
Workbench as described in Chapter 3, “Using the Project Wizard to Create or Modify 
a Project,” on page 11. At the start of a session, the Project Wizard's fields are 
populated by the SCLM Suite Administrator Workbench's default values, or, if you 
are modifying an existing project, that project’s previously-defined values.  By 
selecting the appropriate tabs at the bottom of each Project Wizard page, you can 
move between the various pages of the Wizard until you have completed you project 
definition or modification.  The pages  you use are the same for both project creation 
and project modification.  As you define various aspects of your project, you can 
review the associated XML source code by clicking the Source tab, found at the 
bottom of each Project Wizard page. You must not edit this XML source outside of 
SCLM Suite Administrator Workbench.

Creating a new SCLM project -- the work flow

Once you have started SCLM Suite Administrator Workbench, you will perform the 
following tasks to create a new SCLM project:

• Right-click SCLM Admin Workbench in the Navigator tree and select New SCLM 
Project.

• During the customization of your client workstation, you may have defined 
default Types for your profile using the SCLM Suite Administrator Workbench 
Preferences.  To review the way in which this was accomplished, see “Defining 
default Types and setting their DCB values” on page 14.

• Name the project and define the project management working data sets; see  
“Defining default data sets for the project” on page 15 and “Defining project 
settings” on page 16.

• Define your control data sets; see “Defining control data sets” on page 17.

• Select the Types you want to include in your project; see “Adding or removing 
Types” on page 18.

• Optionally, create authorization groups and authorization codes; see “Adding or 
removing authorization groups and authorization codes” on page 20.

• Define groups for your project and the promotion hierarchy; see “Adding or 
deleting groups” on page 20.

• Select the group/Type combinations to be allocated; see “Specifying group/Type 
allocations” on page 21.

• Define or select language definitions; Chapter 6, “Using the Language Definition 
Wizard,” on page 37.
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• Select any user exits you will require; see “Specifying user exit information” on 
page 22.

• Save and build your project; see “Building or rebuilding your project” on page 23.

At any time during the project creation or editing process, you may choose to save 
your project or quit your work. To save at any time, click the Save icon.  When you 
want to quit work, SCLM Suite Administrator Workbench displays the Save Resource 
dialog, on which you can choose whether or not to save your changes before closing 
the session.  

If you try to save a project and receive a message indicating that the Save failed at the 
host, you can correct the problem and then click the Save icon again.  One cause of 
such a message is an instance where you may have worked on the project at the host 
system and did not close the project before starting to work at the workstation.  In this 
case, closing the project on the host system should allow you to save your work from 
the workstation.

When you build or rebuild a project and the save fails on the host, SCLM Suite 
Administrator Workbench discontinues the build or rebuild. 

Note:  A new Preferences page in Remote Systems Explorer  6.0.3 permits you to 
control file cache size and clear the cache. If you do so while you have an open project, 
you will impact your ability to correctly save your project. Thus, you must not clear 
the cache while you have projects open in SCLM Suite Administrator Workbench. 

Working with an existing project

Once you have started to define a project, its name appears in the project list in the 
Remote Systems Navigator tree,  Projects you have started to define can be classified 
as complete, complete and parsed, incomplete, or corrupt.  The state of a project is 
reflected in the state of the blue icon that precedes the project’s name in the Navigator 
tree.  A project can be:

• Complete

• Incomplete -- some additional work is required to complete this project definition.

• Corrupted -- Some of the project definitions contain errors.

• Parsed -- if the XML code for a project has been generated.

To work with an existing project, click its name in the Navigator tree.  The Project 
Wizard displays, with fields populated by the values you have previously entered.

Defining default Types and setting their DCB values

SCLM Suite Administrator Workbench provides a number of  fully-defined default 
Types which you can choose to include in your project as is.  You can use the Default 
Types Preference page to modify the Type definition for these types or to define new 
Types.  You may already have worked with the product’s default Types when 
customizing the workstation client. To access the Default Types Preference page, 
expand the SCLM Admin Workbench item in the Preferences Navigator Tree by 
selecting the following from the Window pulldown: Window > Preferences > SCLM 
Admin Workbench > Default Types Preference Page.  To  add a default Type to your 
project, on the Preferences page, select the Type to be added from the list of default 
Types and click the Add button.    To edit an existing default Type, click the Edit 
button.  SCLM Suite Administrator Workbench displays the  Type Dialog on which 
you can specify or edit the selected Type information:

1. A name of up to 8 characters and a description for the Type. (If you are editing an 
existing Type, its name is filled in this field.)
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2. The average number of records contained in the top-level data set of this Type. 
This mandatory value, together with the number of members value and the DCB, 
is used to calculate the space required for the PDS or PDS-E at the top of the 
promotion tree.

3. The number of members contained in the top-level Type data set. This mandatory 
value, together with the average number of records value and the DCB, is used to 
calculate the space required for the PDS or PDS-E at the top of the promotion tree.

4. An extended Type name of up to 8 characters that can be used as an alternate 
Type if it is necessary to resolve include dependencies.

If  a Type has been defined as using package backout:

1. Specify a number in the Reuse Days text box to indicate the number of days for 
which a backout can be performed. This field can only be specified if you check 
ISA Pack for this Type.

2. Click the Pkg Bkup check box to specify that this Type of file is to be backed up 
during a promote.

3. Click the ISA Pack check box to specify that this architecture definition will be 
used to drive the packages that are permitted to be backed out.  This flag can be 
specified only for architecture definition  (ARCHDEF) Types.

4. Click the Pack File box to specify that this Type is to hold the package detail files.

Specify the following default DCB information for the Type:

• The default DCB record format. Valid formats are FB, FBA, VB, VBA, FBM, VBM, 
or U. 

• The default DCB block size. Valid value is an integer from 32 — 32760

• The default DCB logical record length. Valid value is an integer from 32 — 32756. 

Note:  When you add a new Type to your project, you should ensure that:

— If RECFM=U, LRECL must be equal to 0. BLKSIZE must not be equal to 0, 
and must be less than or equal to 32760.

— If RECFM=VBx, LRECL must not be equal to 0. BLKSIZE must be equal to 0, 
or must be greater than LRECL + 4 and less than or equal to 32760.

— If RECFM=FBx, LRECL must not be equal to 0. BLKSIZE must be equal to 0, 
or must be an exact multiple of LRECL and less than or equal to 32760.

When you have completed your entries on this page, click OK.  At any time, you can 
return to this page to modify your entries, to remove a default Type from your profile, 
or to restore the product’s default settings.

Defining default data sets for the project

When you right-click SCLM Admin Workbench and select New Project, SCLM Suite 
Administrator Workbench presents you with the Default Data Sets dialog.  On this 
panel, you can specify:

• The format of your project’s data sets, either PDS or PDS-E.  PDS-E is the default. 
When you are modifying a project, the value you enter here will affect only newly 
created library data sets. Existing data sets will remain unchanged.

• Fully qualified data set names for each Type of data set you want to include in 
your project. Clicking on Browse displays the data set name set to the default 
value, which you can change if you wish.  The  project definition data sets 
(projectname.projdefs.*)  contain administration JCL, PROCs, CLISTs, SOURCE, 
OBJECT, LISTINGS, LINK MAPS, and Work files. Typically, the format for the 
data set name is  projname.groupname.typename, where projname is the name of your 
 Chapter 4.   Using the Project Wizard from the Workstation to Create or Modify a Project  15



 

project, groupname is a name you will specify for this data set group, and typename 
is the name of the type of data this data set will contain.  The associated SCLM 
variables are @@FLMPRJ, @@FLMGRP, and @@FLMTYP, respectively.

• Fully qualified data set names for each SYSLIB data set you want to include in 
your project.  Clicking on Browse  displays the data set name set to the default 
value, which you can change if you wish.  You must define at least one SYSLIB 
data set.  The SYSLIB data sets hold standard IBM macros as well as any 
languages definitions you may define.

The high level qualifier that SCLM Suite Administrator Workbench uses for your 
default data sets is AUZ, unless you have specified that another value be used.  To 
specify that SCLM Suite Administrator Workbench use another value, change your 
SCLM Suite Administrator Workbench Preferences by selecting Window > 
Preferences > SCLM Admin Workbench. On this page, specify a value to be used by 
the project editor as the default data set search filter in the case where you have not 
provided a filter in a text field. The default data set search filter is AUZ. For example, 
if you are using the Default Data Set Dialog and press the Browse  button without 
entering a data set name or filter in the text field, SCLM Suite Administrator 
Workbench will use the value you have entered here as the filter.

Defining project settings

On the Wizard's Project Settings page, the values you are asked to enter include:

• The name, of up to 8 characters in length, of the new project. If this is an existing 
project, its name appears in the Project Name or Alternate Name text boxes.

• Whether it is an alternate project, and, if so, the alternate project’s name.  The 
alternate project name may not exceed 8 characters in length.

• The DASD Unit where the project’s data sets will reside.  The default is 
SYSALLDA.

• The Virtual Input/Output (VIO)  unit to be used to store temporary data sets.  The 
default is VIO.

• The maximum number of records permitted for VIO allocation.  The default is 
5000.

• The maximum number of lines per page for all SCLM reports.  The minimum 
value is 35.

• Whether translator option overrides are allowed.  Check the box to specify that 
developers can override translator options  for any of the languages by using the 
PARM statement in the architecture members.  If you do not permit translator 
overrides, SCLM uses only those translator options you specify in the language 
definition for the translators. .

• Whether VSAM record level sharing (RLS) is available. Check the box to specify 
that RLS can be used.

To define or edit the default data set information for the project, click the Default 
Data Sets button.

Recommendations and suggestions

You will want to complete the project definition tasks above before you migrate assets 
into your project and create architecture definitions for your project.  Additionally, 
you will want to migrate assets into your project prior to creating architecture 
definitions.
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Defining control data sets

Use the control data sets page to assign fully-qualified data set names to the project's 
control data sets. You can also use this page to specify whether your project will have 
alternate control data sets. If you want alternate control data sets, click the 
appropriate radio button to indicate that the data set names you are providing are 
alternate control data set names and assign an identifier of up to 8 characters for the 
alternate control datasets.  Then click Add to display the Control Data Sets dialog.  

On the Control Data Sets dialog, assign fully qualified names for the primary or  
alternate control data sets. Also, specify the following information:

• In the optional Data Set Name text field, specify the data set naming convention 
for the project  

• In the text boxes provided, specify a fully-qualified name for each control data set.

•  In the boxes provided, specify the primary and secondary allocation for the 
control data sets.  The default  for the primary allocation is 2 cylinders and for the 
secondary allocation, 4 cylinders.

When you have completed your set of control data set or alternate control data set 
definitions, click OK  to add the set to the list of any previously-defined sets that 
appears in the Control Data Sets Information list box on the Control Data Sets page.  

To remove a set of control data sets from this list box, highlight the set, then click 
Remove. To edit a set of control data sets, highlight the set’s name in the list box, then 
click Edit.

Each project must have at least one primary accounting data set. This data set contains 
information about application programs in the project. The secondary accounting 
data set is optional and is used as a backup for your primary accounting data set. The 
data set name you specify must be the same as the name of the VSAM cluster you 
want to use.

The export accounting data set is optional unless you plan to use the import and 
export functions. The data set name you specify must be the same as the name of the 
VSAM cluster you want to use. It must not have the same name as either the primary 
or secondary accounting data set.

Audit control data sets contain information about changes to SCLM-controlled 
members that are located in groups being audited. Audit control data sets must be 
created before you can use SCLM's audit function. The high level qualifier of the audit 
control data sets must be an entry in a VSAM catalog. If you will specify on the  
Group/Type Dialog that auditing is to be used, you must have at least one primary 
audit control data set. The secondary audit control data set is optional and is used as a 
backup for your primary audit data set. When specifying the parameters for the 
primary and secondary audit control data sets, you may not use SCLM variables; that 
is @@FLM***.

The Version PDS name identifies the partitioned data set where version data and 
SCLM variables are stored.  If you will specify on the  Group/Type Dialog that 
versioning is to be used,  you must specify a value in the Version PDS Name field on 
this dialog.  This dialog also permits you to specify the number of versions to keep in 
the version partitioned data set. If you specify 0, all versions associated with a 
member will be retained. If you specify a value of 2 or more, each time a member is 
saved or promoted, the latest copy of the version is stored and the earliest copy is 
discarded. Any audit records that were associated with the version are retained but 
will no longer indicate that a version of the member exists. If you specify a value of 2 
or more, allocate a separate VERPDS for each group that has versioning enabled. This 
value may not be specified for alternate control data sets.   The value in this field can 
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be overridden by the value you may specify in the Number of Versions field on the 
Group/Type dialog.

Some additional considerations and restrictions

When defining  the project’s control data sets using the macros FLMCTRL (primary 
control data sets) and FLMALTC (alternate control data sets), ensure that:

• Each occurrence of an FLMALTC macro has at least one ALTC parameter on an 
FLMGROUP (group definition) macro pointing to it.

• FLMCTRL and FLMALTC macros do not use SCLM variables when specifying 
the ACCT (primary accounting data set) and ACCT2 (secondary accounting data 
set) parameters.

• FLMCTRL and FLMALTC macros do not use SCLM variables when specifying 
the VERS (primary versioning data set) and VERS2 (secondary versioning data 
set) parameters.

• FLMCTRL and FLMALTC macros use only @@FLMPRJ, @@FLMGRP, and 
@@FLMTYP when specifying the DSNAME parameter.  If the DSNAME 
parameter is specified, it must include @@FLMTYP.

• FLMCTRL and FLMALTC macros use only @@FLMPRJ, @@FLMGRP, and 
@@FLMUID when specifying the EXPACCT parameter. 

• FLMCTRL and FLMALTC macros use only @@FLMPRJ, @@FLMGRP,  
@@FLMTYP, and @@FLMDSN when specifying the VERPDS parameter.  If 
@@FLMDSN is used, it must appear in the first 8 characters of the specification. 

 

Adding or removing Types

The Types page permits you to  specify the Types that will be included in your project, 
and define the characteristics of those Types.  Typically, a Type names the kind of data 
a given data set contains—for example, LOAD, SOURCE, or JCL.  Type is normally 
the third qualifier in a project library’s fully-qualified data set name.  Your project 
must contain at least one Type.  Otherwise, it cannot be built.  Additionally, if you 
have specified a Type at a lower level of the hierarchy, that Type must persist all the 
way to the top of the hierarchy.

 On this page you can add a Type or multiple Types to your list of default Types; or 
add a Type or multiple Types to your project, as follows:

• To move a default Type into your project, click its name in the Default Types list 
box and then the right-pointing arrow (>) to move it to the Selected Types list.  

• To  move all of the Types from the Default Types list box to the Selected Types list, 
click the double arrow (>>).  

• To move multiple types from the Default Types list box to the Selected Types list 
box, hold down the Ctrl key to select the Types you want to move, then click the 
right-pointing arrow  (>).

You can remove a Type or multiple Types from your project as follows:

• To remove a Type from your project, select its name in the Selected Types list box 
and click the left-pointing arrow (<).

• To remove multiple types from the Selected Types list box to the Default Types list 
box, hold down the Ctrl key to select the Types you want to move, then click the 
left-pointing arrow  (<)

• To remove all of the Selected Types, click the double left-pointing arrow (<<).
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When you decide to remove a Type or Types from your project:

• The Wizard  asks you to  confirm the removal of the Type. If you select the No 
button, no action is taken.

• If you select the Yes button, then the Wizard asks whether you want to also delete 
the data associated with this Type.  If you select No,  then only the Type is deleted.  
If  you select Yes, then the Type and any associated data sets for this Type are 
deleted.

Note that this behavior  differs when you take similar actions using the ISPF  
interface.  When using the ISPF interface at the host, you are asked to confirm the 
deletion of the object and the deletion of associated data only from the Group/Type 
panel.

To define a new Type, click the Add  button.  Or, to modify an existing Type, you can 
define or edit its characteristics by clicking its name and the  Edit button. Either of 
these actions displays the Types Dialog. 

 In the Types Dialog,  specify or edit:

1. A name of up to 8 characters and a description for the Type. (If you are editing an 
existing Type, its name is filled in this field.)

2. The average number of records contained in the top-level data set of this Type. 
This mandatory value, together with the number of members value and the DCB, 
is used to calculate the space required for the PDS or PDS-E at the top of the 
promotion tree.

3. The number of members contained in the top-level Type data set. This mandatory 
value, together with the average number of records value and the DCB, is used to 
calculate the space required for the PDS or PDS-E at the top of the promotion tree.

4. An extended Type name of up to 8 characters that can be used as an alternate 
Type if it is necessary to resolve include dependencies.

If  a Type has been defined as using package backout:

1. Specify a number in the Reuse Days text box to indicate the number of days for 
which a backout can be performed. This field can only be specified if you check 
ISA Pack for this Type.

2. Click the Pkg Bkup check box to specify that this Type of file is to be backed up 
during a promote.

3. Click the ISA Pack check box to specify that this architecture definition will be 
used to drive the packages that are permitted to be backed out.  This flag can be 
specified only for architecture definition  (ARCHDEF) Types.

4. Click the Pack File box to specify that this Type is to hold the package detail files.

Specify the following default DCB information for the Type:

• The default DCB record format. Valid formats are FB, FBA, VB, VBA, FBM, VBM, 
or U. 

• The default DCB block size. Valid value is an integer from 32 — 32760

• The default DCB logical record length. Valid value is an integer from 32 — 32756. 

Note:  When you add a new Type to your project, you should ensure that:

— If RECFM=U, LRECL must be equal to 0. BLKSIZE must not be equal to 0, 
and must be less than or equal to 32760.

— If RECFM=VBx, LRECL must not be equal to 0. BLKSIZE must be equal to 0, 
or must be greater than LRECL + 4 and less than or equal to 32760.

— If RECFM=FBx, LRECL must not be equal to 0. BLKSIZE must be equal to 0, 
or must be an exact multiple of LRECL and less than or equal to 32760.
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Adding or removing authorization groups and authorization codes

To access the Authorizations Page, select the Authorizations tab from the bottom of a 
page in the Project Wizard. You can use the Authorizations page to:

• Add or remove an authorization group or authorization code 

• Assign an authorization code or codes to an authorization group or remove them 
from the group

• View the previously defined authorization codes belonging to a given 
authorization group

To add an authorization group or authorization code , enter its name, of up to 8 
characters in length, in the appropriate text box at the top of the page and  press the 
Add button. If you have entered a new authorization code after an authorization 
group has been defined on this page, it is assumed that the new authorization code 
belongs to (is a dependent of) the authorization group whose name is currently 
highlighted in the Authorization Groups list box. 

To remove an authorization group or authorization code from the project, click its 
name in the appropriate list box. Then click the Remove button. If you remove an 
authorization group that has dependent authorization codes, those authorization 
codes are also removed from the project.

To view all of the previously-defined authorization codes you have assigned to a 
given authorization group, click that group in the Authorization Groups list box.  All 
of the authorization codes you have assigned to this group are displayed in the 
Authorization Codes list box.

You must ensure that there are no loops when you define your authorization groups 
and authorization codes.  An example of what to avoid is the case where 
authorization group AGRP1 contains authorization codes A, B, C, AGRP2, and 
authorization group AGRP2 contains authorization codes A, B, D, AGRP1. This 
specification is invalid.

Adding or deleting groups

Selecting the Group tab from the bottom of a page in the Project Wizard displays the 
Groups page. 

A group is equivalent to a node within a project hierarchy.  For example, in a code 
development project, Development, Test, and Ship can each be considered a group.  
Data sets having the same midlevel qualifier in their fully qualified names can be 
considered as belonging to the same group. Rules that govern your ability to move or 
copy data between groups are specified by the authorization codes associated with a 
group. Your project must contain at least one group.  Otherwise, it cannot be built. 

All groups, except the top-most group in a project hierarchy, must promote to another 
group.  All groups specified as Development must be specified as a key group.  The 
topmost group in a hierarchy must also be specified as a key group.

When defining promotion from group to group, there can be no loops. Thus, for 
example, you cannot define a promote sequence that has group A promoting to group 
B which in turn promotes back to group A. Doing so will cause a project build or 
rebuild to fail.

 To add a new group, on the Groups page, enter a name for the group of up to 8 
characters.   The name of the group must be unique for this project and must be valid 
for a data set qualifier.  Then click Add Group to add this to your project.
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SCLM Suite Administrator Workbench now displays a box, the name of which is the 
name of the group you specified. You can continue to add boxes by naming them and 
clicking Add Group, then dragging and dropping them around the blank area of the 
page.  Each box represents an SCLM group. As you place each box on the blank panel 
or 'canvas',  you can link each new box to an existing box or boxes, in the same way as 
you might create an organization chart in a drawing package. 

To link a group to its promote group, first right-click the group, then right-click the 
group to which members of the first group will be promoted.  SCLM Suite 
Administrator Workbench inserts a line showing the relationship between the groups.

To  remove a group from your project, click the group, then Remove.  

• The Wizard  asks you to confirm the deletion of the group. If you select the No 
button, no action is taken.

• If you select the Yes button, then the Wizard asks whether you want to also delete 
the data associated with this group.  If you select No,  then only the group is 
deleted.  If  you select Yes, then the group and any associated data sets for this 
group are deleted.

Note that this behavior  differs when you take similar actions using the ISPF  
interface.  When using the ISPF interface at the host, you are asked to confirm the 
deletion of the object and the deletion of associated data only from the Group/Type 
panel.

To  define the attributes for a group, double-click it to display the  Group Dialog. On 
this dialog, for the group you have chosen:

1. Select the name of the group to which members of this group will be promoted 
from the drop down box provided.

2. Specify a name of up to 8 characters for the data set that defines an alternate set of 
control options to be used for this group.

3. Specify a name of up to 8 characters for the Package Backout Group.  You must 
have defined package backout for the current group in order to specify this 
option.

4. Check the Member Restore check box to specify that, for this backout group, 
member restore is in effect.  If you check Member Restore, SCLM will restore 
individual members rather than an entire package.  You must have defined 
package backout for the current group in order to specify this option.

5. Check the Key check box to specify that the group you are defining is a key group. 
If you identify a group as a key group, data moved to this group is erased from 
the group from which it was promoted.  If you do not identify this group as a key 
group, then data moved to this group is copied from the group from which it was 
promoted.

6. Select the authorization codes to be associated with this group by moving them 
from the Available list to the Selected list.

Specifying group/Type allocations

Use the Group/Type page to select from the group/Type combinations in your 
project, those for which you want to change existing allocations. To move a 
group/Type to the Group/Type Allocations list box, click its name and then the right-
pointing arrow (>).  To override the default allocations for all of the group/Type 
combinations, click the right-pointing double arrow (>>). 

To remove a group/Type combination from the Group/Type Allocations list, select its 
name and the left-pointing arrow (<).  To remove all of the combinations from the 
Group/Type Allocations list, click the double left-pointing arrow (<<).
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• The Project Wizard  asks you to confirm the removal of a group/Type from your 
project. If you select the No button, no action is taken.

• If you select the Yes button, then the Wizard asks whether you want to also delete 
the data associated with this group/Type.  If you select No,  then only the 
group/Type is deleted.  If  you select Yes, then the group/Type combination and 
any associated data sets  are deleted.

Note that this behavior  differs when you take similar actions using the ISPF  
interface.  When using the ISPF interface at the host, you are asked to confirm the 
deletion of the object and the deletion of associated data only from the Group/Type 
panel and you are not permitted the opportunity to confirm deletion from either the 
Types panel or Groups panel.

Place a check in the Sort by Type checkbox to reorder the group/Type combinations in 
both list boxes by Type.

Once a group/Type combination is in the Allocations list, to override its defaults, click 
its name, then the Edit button. SCLM Suite Administrator Workbench displays the 
Group/Type Dialog.

On the Group/Type Dialog, the text box at the top of the page displays the name of 
the group/Type combination for which you are  overriding default allocation values.  
On the dialog:

1. Specify the allocation units—Tracks, Cylinders,  or Blocks

2. Specify the number of primary  and secondary allocation units

3. Place a check mark in the appropriate box to specify whether auditing is active for 
this group/Type. If you specify that auditing is active, you must have specified a 
name for the audit data set on the Control Data Sets dialog. If you specified that 
auditing is active, you can now define information for version data sets, including

• Whether check sum is in effect

• The number of versions to be retained. When the number you have specified 
is reached, the latest version is kept and the earliest version is discarded.  The 
value in this field will override the value you specified in the Versions to 
Retain field on the Control Data Sets dialog.

• The sequence number type which may be  STANDARD, STD, COBOL, or 
NONE.  NONE is the default. 

If you will use versioning, you must have specified a Version PDS Name on the 
Control Data Sets dialog.

Adding or deleting language definitions

To add a language definition to or delete one from your project, use the Language 
Definition Wizard.  For information, see Chapter 6. Using the Language Definition 
Wizard, the section titled “From the workstation” on page 37.

Specifying user exit information

Use the User Exits page to perform the following tasks: 

1. To specify that the Breeze product is installed and you wish to configure Breeze 
User Exits, place a check in the appropriate check box.  If you place a check in the 
check box, the name of the data set containing the Breeze User Exits is displayed 
for you.  You can change this information by overtyping it.

2. Select from the list of Default User Exits those exits that will be included in your 
project. To select a single exit, click its name and then click the single arrow (>) to 
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move it to the Selected User Exits list box. To select all of the Default exits, simply 
click the double arrow (>>). You can select multiple Default Exits by holding 
down the Ctrl key and clicking only those exits you want to move to the Selected 
list box, then clicking the single arrow (>). 

3. Once you have moved all of the exits you want to work with to the Selected User 
Exits list box, you can configure them by first clicking the exit's name and then the 
Edit button. Doing so causes SCLM Suite Administrator Workbench to display 
the User Exits dialog. Using the User Exits dialog, you can configure an 
individual exit by

a. Specifying the module name where the exit code is stored

b. Specifying the Load Data Set name that contains the module

c. Selecting the Exit invocation method—linked, attached, invoked by TSO, or 
called through ISPF services 

d.  Entering the option list to be passed to the user exit routine.  You can specify 
a maximum of 255 characters, including delimiters, for the options. Enclose 
the option string in parentheses or single quotes.

To remove an exit from the Selected list box, click its name, then the left-pointing 
single arrow (<). Move all of the exits out of the Selected box by clicking the left-
pointing double arrow (<<). You can remove multiple exits by holding down the Ctrl 
key and clicking only those exits you want to remove from the Selected list box, then 
clicking the left-pointing single arrow (<). 

Building or rebuilding your project

Once you have defined or modified those the objects comprising your project, you can 
review the created XML source code by pressing the Source tab at the bottom of a 
Project Wizard panel. If you are satisfied with your entries, you are ready to build 
your project.  Before initiating the build, you must ensure that your project contains at 
least one Type and one group.  Otherwise, your build will fail.

To do so:

1. In the Navigator tree at the left side of your workspace, right-click on the name of 
your project. 

2. From the pop-up list that SCLM Suite Administrator Workbench displays, click 
Rebuild Project.

If you are building or rebuilding a project and an error occurs, a file called 
error.number.tar is created.  Save this file and call your support person.  You can also 
review the contents of the file by entering TAR on the UNIX System Services 
command line.

If  your project fails to build...

If your project fails to build: 

• Ensure that you have defined at least one group and one Type for your project.

• Ensure that there are no loops in your promote hierarchy.  Thus, for example, you 
cannot define a promote sequence that has Group A promoting to Group B, 
promoting to Group C, which promotes back to Group A.

• Similarly, you must ensure that there are no loops when you define your 
authorization groups.  An example of what to avoid is the case where 
authorization group AGRP1 contains authorization codes A, B, C, AGRP2, and 
authorization group AGRP2 contains authorization codes A, B, D, AGRP1. 
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Chapter 5. Using the Project Wizard from an  ISPF Session to 
Create or Modify a Project

This chapter describes the creation of a new project or the modification of an existing 
project using the Project Wizard from  an ISPF host session.  For information about 
using the Project Wizard from a workstation, see Chapter 4, “Using the Project Wizard 
from the Workstation to Create or Modify a Project,” on page 13.

Start working with your project from the Project Administration Main Menu by 
specifying an appropriate option on the Option line. 

   

 

 At the start of a session, the Project Wizard's fields are populated by the SCLM Suite 
Administrator Workbench's default values if you are creating a new project, or by the 
values specific to a previously-defined project, if you are modifying a project.

Navigating the ISPF interface

When creating or editing a project, you can navigate through the ISPF interface in 
several ways.

1. You can use the SCLM Project Quick Menu to move from function to function in 
the order you select from this menu.  The Quick Menu is displayed to you:

• Immediately after you press Enter on the Settings panel when creating a new 
project.

• When you choose the E option on the Project List panel to edit an existing 
project. 

• When you press PF4 - Qmenu on those panels where this option is displayed 
in your PF key list.

Note:  When you are creating a project initially, some project definition functions 
should be completed before moving to other functions.  See “Recommendations 
and suggestions” on page 27.

2. Alternatively, you can move forward sequentially from panel to panel through 
the Project Wizard using the Enter key and backward using PF3, defining your 
project using the panel order controlled by the Project Wizard.  

Table 1. Options  from the SCLM Suite Administrator Workbench Main Menu

Option Action

1 Define project settings. Choose this option to create job card information, 
specify whether jobs will run in batch or online, and, optionally, update the 
default Types for your project.

2 Create a New SCLM Project. Choose this option to initiate the Project 
Wizard, where you can define your project.

3 List SCLM Projects. Choose this option to display a list of existing SCLM 
projects. From this list, you can edit,  delete, or clone a project, or initiate 
various other project functions such as architecture definition, asset 
migration, or VSAM file maintenance.

X Exit SCLM Suite Administrator Workbench.
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3. Some project functions can be accessed from the Project List panel by specifying 
the appropriate line command next to a project’s name.

Defining project administration settings

Select Option 1 on the Main Menu to define project administration settings.  On the 
Project Wizard's Settings panel:   

• Specify whether or not to run jobs in batch.  To indicate that jobs are to be run in 
batch, specify B on the line provided. Otherwise specify F to run in the 
foreground.

Use the space provided to type in the appropriate JCL to run these  jobs.

• Specify whether to update the default types for your profile.  Your profile has a 
number of default types defined for it.  If you specify U on the Options line, the 
Default Types panel displays.  On this panel, you can edit or view the Types for 
your profile, delete Types from your profile, or define new Types.  See  Defining 
default Types for your profile, below.

Creating a new SCLM project -- the work flow

Select Option 2 on the Main Menu to use the Project Wizard to create a new project.  
Creating a new project comprises the tasks that follow.  Note that, as soon as you have 
started creating a project, project information is created and stored.  Even if you 
should quit your work before the project is fully defined, and you wish to continue 
work on the project, you must access that project from the Project List panel.  Do not 
use the Create Project function to continue. 

• Defining default Types for your profile; see “Defining default Types for your 
profile” on page 27.

• Defining the default data sets for a project; see“Defining default data sets for the 
project” on page 27.

• Defining project settings; see “Defining project settings” on page 28.

• Defining the project’s control or alternate control data sets; see“Defining project 
control data sets” on page 29.

• Selecting the Types that are relevant for the project from the list of default Types; 
see“Selecting Types for your project” on page 30.

• Defining the group hierarchy; see “Working with groups” on page 31, “Creating 
or modifying a group” on page 32, “Defining authorization groups and 
authorization codes” on page 32, and “Creating or modifying an authorization 
group” on page 33.  The use of authorization groups and authorization codes is 
optional.

• Deciding which group/Type data sets should be allocated and performing the 
allocation; see “Allocating group/Type combinations” on page 33 and 
“Overriding default allocations” on page 34.

• Configuring user exits; see “Specifying User Exit information” on page 34.

• Creating or importing language definitions; see Chapter 6, “Using the Language 
Definition Wizard,” on page 37.

• Migrating assets into the SCLM project; see Chapter 9, “Migrating Software 
Assets into your Project,” on page 55.

• Creating architecture definitions; see Chapter 11, “Using the Architecture 
Definition Wizard,” on page 59.
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Recommendations and suggestions

When creating a project,  you will want to ensure that you have migrated assets into 
the project prior to creating architecture definitions.

Defining default Types for your profile

Use the Default Types panel to view, edit, or delete default Types for your profile.  You 
can view a Type’s default definition  by specifying V on the line preceding a Type.  
You can edit a Type’s  default definition by specifying E.  Press Enter to process your 
choices.  In either case, the Project Wizard  displays an ISPF Edit panel, with 
information about the Type you selected filled in.  Note that you can update this 
information only if you accessed this panel using an Edit (E) request.

You can also use the Default Types panel to delete a Type or multiple Types from your 
profile  by specifying D in front of the Type or Types to be deleted.  Once you have 
confirmed your choice to delete a Type or Types,  SCLM Suite Administrator 
Workbench removes these from the list of Types associated with your profile.

Adding a new default Type

 From the Default Types or Selected Types panels,  you can  add a new default Type by 
specifying N on the Options line.  The Project Wizard displays the SCLM Types panel, 
on which you specify:

• A name of up to 8 characters in length for the new Type

• A description of the Type

• The default DCB information:

— The default DCB record format. Valid formats are FB, FBA, VB, VBA, FBM, 
VBM, or U. 

— The default DCB block size. Valid value is an integer from 32 — 32760

— The default DCB logical record length. Valid value is an integer from 32 — 
32756. 

Note:  When you add a new Type, you should ensure that:

– If RECFM=U, LRECL must be equal to 0. BLKSIZE must not be equal to 0, 
and must be less than or equal to 32760.

– If RECFM=VBx, LRECL must not be equal to 0. BLKSIZE must be equal 
to 0, or must be greater than LRECL + 4 and less than or equal to 32760.

– If RECFM=FBx, LRECL must not be equal to 0. BLKSIZE must be equal to 
0, or must be an exact multiple of LRECL and less than or equal to 32760.

After each execution of the Edit SCLM Type panel to define a new Type or edit an 
existing type, pressing PF3 saves  your work and completes the Type definition 
process.

Defining default data sets for the project

Once you have filled in a project name and alternate project name, if any, on the Main 
Menu and selected Option 2, SCLM Suite Administrator Workbench presents you 
with the Default Data Sets panel.  On this panel, you can specify:

• Whether project data sets will be in PDS or PDS-E format

• Fully qualified data set names for each Type of data set you want to include in 
your project
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• Fully qualified data set names for each SYSLIB data set you want to include in 
your project.  You must define at least one SYSLIB data set.  The SYSLIB data sets 
hold standard IBM macros as well as any languages definitions you may define.

Working with the project list to edit your project or  initiate wizards

Selecting Option 3 on the Main Menu presents you with the Project List panel.  This 
panel lists the project name, alternate project name, if any, and the state and status of 
the projects.  Not every project will have an alternate project.  

You can filter the list of projects presented to you on the Project List panel by filling in 
a project name or a partial name and asterisk as a wild card to limit the number of 
projects displayed on the Project list panel.

When the project list displays, you can specify appropriate codes to initiate SCLM 
Suite Administrator Workbench actions on the Cmd line preceding each project. 

The State column can have one of these values:

• Incomplete -- some additional work is required to complete this project definition.

• Corrupted -- Some of the project definitions contain errors.

• Parsed -- if the XML code for a project has been generated.

If a project is complete, the State column is blank.

From the Project List panel, you can take the following actions:

• If you specify an A on the line preceding a project’s name, SCLM Suite 
Administrator Workbench displays the Architecture Definition wizard.  See 
Chapter 11, “Using the Architecture Definition Wizard,” on page 59 .

• If you specify a C on the line preceding a project’s name, SCLM Suite 
Administrator Workbench displays the Clone Project panel. See Chapter 8, 
“Cloning an Existing Project,” on page 53.

• If you specify a D on the line preceding a project’s name, SCLM Suite 
Administrator Workbench will delete your project after confirmation from you.  
See Chapter 7, “Deleting a Project or Other SCLM Objects,” on page 49.

• If you specify an E on the line preceding a project’s name, SCLM Suite 
Administrator Workbench displays the Project Editor.  

• If you specify an M on the line preceding a project’s name, SCLM Suite 
Administrator Workbench displays the Migrate Assets panel.  See Chapter 9, 
“Migrating Software Assets into your Project,” on page 55.

• If you specify a P on the line preceding a project’s name, SCLM Suite 
Administrator Workbench reparses your project after confirmation from you. 

• If you specify a V on the line preceding a project’s name,  displays the VSAM 
Tasks panel.  See Chapter 10, “Maintaining the Project’s VSAM Files,” on page 57.

• If you type OUTPUT on the Option line, SCLM Suite Administrator Workbench 
displays the output of the last script you have run.

Defining project settings

On the Wizard's Project Settings page, the values you are asked to specify  include:

• The name, of up to 8 characters in length, of the project

• Whether it is an alternate project, and, if so, the alternate project’s name.  The 
alternate project name may not exceed 8 characters in length.
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• The DASD Unit where the project’s data sets will reside.  The default is 
SYSALLDA.

• The Virtual Input/Output (VIO)  unit to be used to store temporary data sets.  The 
default is VIO.

• The maximum number of records permitted for VIO allocation.  The default is 
5000.

• The maximum number of lines per page for all SCLM reports.  The minimum 
value is 35.

• Whether translator option overrides are allowed.  Place an S or a slash (/) on the 
line to specify that developers can override translator options  for any of the 
languages by using the PARM statement in the architecture members.  If you do 
not permit translator overrides, SCLM uses only those translator options you 
specify in the language definition for the translators. .

• Whether VSAM record level sharing (RLS) is available.  Place an S or a slash (/) on 
the line to specify that RLS can be used.

After you have completed work on this panel, press Enter to display the Define 
Project Control Data Sets panel.

Defining project control data sets

The Project Wizard now displays a panel on which you can define the accounting,  
auditing,  and versioning data sets and allocate space for them.  Specify a data set 
name for each of the data sets you want to include in your project.  The fully-qualified 
data set name must follow the rules for PDS or PDS-E data sets. 

Optionally specifying a data set name on this panel identifies the data set naming 
convention for the project. The name you specify may be up to 8 characters in length

Each project must have at least one primary accounting data set. This data set contains 
information about application programs in the project. The secondary accounting 
data set is optional and is used as a backup for your primary accounting data set. The 
data set name you specify must be the same as the name of the VSAM cluster you 
want to use.

The export accounting data set is optional unless you plan to use the import and 
export functions. The data set name you specify must be the same as the name of the 
VSAM cluster you want to use. It must not have the same name as either the primary 
or secondary accounting data set.

If you have selected auditing and versioning on the Project Settings panel, you will 
have the opportunity to define audit control data sets. Audit control data sets contain 
information about changes to SCLM-controlled members that are located in groups 
being audited. Audit control data sets must be created before you can use SCLM's 
audit function. The high level qualifier of the audit control data sets must be an entry 
in a VSAM catalog. If you have specified that auditing is to be used, you must have at 
least one primary audit control data set. The secondary audit control data set is 
optional and is used as a backup for your primary audit data set. When specifying the 
parameters for the primary and secondary audit control data sets, you may not use 
SCLM variables; that is @@FLM***.

The Version PDS name identifies the partitioned data set where version data and 
SCLM variables are stored.

Pressing Enter on the Project Control Data Sets panel displays the Alternate Control 
Data Sets panel. 
 Chapter 5.   Using the Project Wizard from an ISPF Session to Create or Modify a Project  29



 

Defining alternate control data sets

On the Alternate Control Data Sets panel, specify a data set name for each of the data 
sets you want to include in your project and allocate space for them.  The fully-
qualified data set name must follow the rules for PDS or PDS-E data sets. 

If you are defining alternate control data sets, you must  specify an identifier, which 
may be up to 8 characters in length.  The rules for naming control data sets above also 
apply to the naming of alternate control data sets.

Use this panel to view, edit, or delete alternate control data sets for your project.  You 
can view a alternate control data sets’ definition  by specifying V on the line preceding 
an alternate control data set name.  You can edit an alternate control data set’s  
definition by specifying E.  Press Enter to process your choices.  In either case, the 
Project Wizard  redisplays the Alternate Control Data Sets panel in edit mode with 
information filled in. Note that you can update this information only if you accessed 
this panel using an Edit (E) request.

You can also use the alternate control data sets panel to delete an alternate control 
data set or multiple data sets  from your project by specifying D in front of the 
alternate control data sets to be deleted.

To define a new alternate control data set, specify  N on the Options line. 

Some additional considerations and restrictions

When defining  the project’s control data sets using the macros FLMCTRL (primary 
control data sets) and FLMALTC (alternate control data sets, ensure that):

• Each occurrence of an FLMALTC macro has at least one ALTC parameter on an 
FLMGROUP (group definition) macro pointing to it.

• FLMCTRL and FLMALTC macros do not use SCLM variables when specifying 
the ACCT (primary accounting data set) and ACCT2 (secondary accounting data 
set) parameters.

• FLMCTRL and FLMALTC macros use only @@FLMPRJ, @@FLMGRP, and 
@@FLMTYP when specifying the DSNAME parameter.  If the DSNAME 
parameter is specified, it must include @@FLMTYP.

• FLMCTRL and FLMALTC macros use only @@FLMPRJ, @@FLMGRP, and 
@@FLMUID when specifying the EXPACCT parameter. 

• FLMCTRL and FLMALTC macros use only @@FLMPRJ, @@FLMGRP,  
@@FLMTYP, and @@FLMDSN when specifying the VERPDS parameter.  If 
@@FLMDSN is used, it must appear in the first 8 characters of the specification. 

 

Selecting Types for your project

Pressing Enter on the Alternate Control Data Sets panel displays the Selected Types 
(FLMTYPE) panel.  The Selected Types panel lists the Types you have defined in your 
profile.  If you are modifying an existing project, the list on this panel shows the Types 
you have defined or selected for your project.  Parameters for these Types will be 
filled in if you have previously entered them. Your project must contain at least one 
Type.  Otherwise, it cannot be built.  

Use this panel to view, edit, or delete Types for your project.  You can view a Type’s 
definition  by specifying V on the line preceding a Type.  You can edit a Type’s  
definition by specifying E.  Press Enter to process your choices.  In either case, the 
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Project Wizard  displays an ISPF Edit panel with information about the Type you 
selected filled in. Note that you can update this information only if you accessed this 
panel using an Edit (E) request.

You can also use the Select Types panel to delete a Type or multiple Types from your 
project by specifying D in front of the Types to be deleted.   SCLM Suite Administrator 
Workbench removes these from the list of Types for your project. Note that you are 
not asked to confirm the deletion of a Type  from your project until you start to work 
with the Group/Type panel.

To define a new Type, specify  N on the Options line. To add a default Type to this 
panel, specify A on the Options line.

For those Types you want to include in your project,  you can provide the following 
information:

1. Specify the number of members contained in the top-level Type data set. This 
mandatory value, together with the average number of records value and the 
DCB, is used to calculate the space required for the PDS or PDS-E at the top of the 
promotion tree.

2. Specify the average number of records contained in the top-level data set of this 
Type. This mandatory value, together with the number of members value and the 
DCB, is used to calculate the space required for the PDS or PDS-E at the top of the 
promotion tree.

3. If you have specified that your project will use package backout:  

a. Place a slash (/) in the Pkg Bkup column to specify that this Type of file is to be 
backed up during a promote.

b. For architecture definition Types, place a slash  (/) in the Flags Packfile 
column to specify that this architecture definition will be used to drive the 
packages that are permitted to be backed out.  

For other Types, place a slash (/) in the Flags Packfile column to specify that 
this Type is to hold the package detail files.

c. Specify a number on the Reuse Limits line to indicate the number of days for 
which a backout can be performed. This field can only be specified if you 
have placed a slash in the Packfile column for this Type.

Defining a new Type

If  you specified  N on the Option line of the Selected Types panel, SCLM Suite 
Administrator Workbench displays the SCLM Type panel.  To understand the 
information required on the Selected Types panel, see “Adding a new default Type” 
on page 27. 

Working with groups

A group is equivalent to a node within a project hierarchy.  For example, in a code 
development project, Development, Test, and Ship can each be considered a group.  
Data sets having the same midlevel qualifier in their fully- qualified names can be 
considered as belonging to the same group. Rules that govern your ability to move or 
copy data between groups are specified by the authorization codes associated with a 
group. Use the Group List panel to view, edit, or delete a group from your project.  
You can also use this panel to create a new group.  Your project must contain at least 
one group.  Otherwise, it cannot be built.  

You can view an existing group  by specifying V on the line preceding its name.  You 
can edit a group by specifying E.  Press Enter to process your choices.  In either case, 
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the Project Wizard  displays the Group  Specification panel. Note that you can update 
this information only if you accessed this panel using an Edit (E) request.

You can also use the  Group List panel to delete a group or groups from your project 
by specifying D  on the appropriate line(s).  SCLM Suite Administrator Workbench 
removes these from the list of groups  for your project.  Note that you are not asked to 
confirm the deletion of a group  from your project until you start to work with the 
Group/Type panel.

To create a new group for your project, specify  N on the Options line.

Creating or modifying a group

Use the Group Specification panel to view, edit, or create a group.  On this panel, you 
can specify or modify the following fields: 

1. If this is an existing group that you are modifying, the group name appears in the 
Group field.   If you are creating a new group, specify a name of up to 8 characters 
in the Group field. The name must be unique for this project and must be valid for 
a data set qualifier.

2. Specify a name of up to 8 characters for the Promote Group.  This is the group to 
which members of the current group are copied or moved.

All groups, except the top-most group in a project hierarchy, must promote to 
another group.  All groups specified as Development must be specified as a key 
group.  The topmost group in a hierarchy must also be specified as a key group.

When defining promotion from group to group, there can be no loops. Thus, for 
example, you cannot define a promote sequence that has group A promoting to 
group B which in turn promotes back to group A. Doing so will cause a project 
build or rebuild to fail.

3. Specify a name of up to 8 characters for the data set that defines an alternate set of 
control options to be used for this group.

4. Specify a name of up to 8 characters for the Package Backout Group.  You must 
have defined package backout for the current group in order to specify this 
option.

5. Place a slash (/) on the Member Restore line to specify that, for this backout group, 
member restore is in effect.  If you specify Member Restore, SCLM will restore 
individual members rather than an entire package.  You must have defined 
package backout for the current group in order to specify this option.

6. Place a slash (/) on the Key line to specify that the group you are defining is a key 
group. If you identify a group as a key group, data moved to this group is erased 
from the group from which it was promoted.  If you do not identify this group as 
a key group, then data moved to this group is copied from the group from which 
it was promoted.

7. Type in the authorization codes to be associated with this group.

When you have completed this panel for a group you are defining or modifying, press 
Enter.

Defining authorization groups and authorization codes

If you have specified on the Project Settings panel that authorization groups will be 
used, SCLM Suite Administrator Workbench displays the Authorization Group List 
panel.  Use this panel to view, edit, or delete  authorization groups for your project.  
You can view an authorization group  by specifying V on the line preceding its name.  
You can edit a group by specifying E.  Press Enter to process your choices.  In either 
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case, the Project Wizard  displays the Authorization Group Authorization Code 
Specification panel. Note that you can update this information only if you accessed 
this panel using an Edit (E) request.

You can also use the Authorization Group List panel to delete an authorization group 
or groups from your project by specifying D  on the appropriate line(s).  Once you 
have confirmed your choice to delete an authorization group or groups,  SCLM Suite 
Administrator Workbench removes these from the list of authorization groups  for 
your project.

To create a new authorization group for your project, place a slash (/) on the 
appropriate line.

Creating or modifying an authorization group

If you have chosen to modify an existing authorization group, the name of that 
authorization group will appear on the Authorization Group line of the Authorization 
Group Authorization Code Specification panel.  Use this panel to specify as many 
unique authorization codes as you choose.  The authorization code names can be  up 
to 8 characters in length.  

If you have chosen to create a new authorization group, specify a name of up to 8 
characters on the line labeled Authorization Group.  Then specify as many unique 
authorization codes as you choose.  The authorization code names can be  up to 8 
characters in length.  

You must ensure that there are no loops when you define your authorization groups 
and authorization codes.  An example of what to avoid is the case where 
authorization group AGRP1 contains authorization codes A, B, C, AGRP2, and 
authorization group AGRP2 contains authorization codes A, B, D, AGRP1.  This 
specification is invalid.

When you are satisfied with your work, press Enter to create, edit, or view another 
authorization group.

Allocating group/Type combinations

After you have defined your groups, you will have an opportunity to allocate space or 
override the default allocations for your group/Type combinations.  Press Enter on 
the Group List panel to display the Group/Type Allocations panel.  To allocate a 
group/Type combination, place an E in the Cmd column.  Doing so displays the 
Group/Type Parameters panel for this group/Type combination. Placing a V in the 
Cmd column displays the Group/Type Parameters panel, but you cannot edit the 
information that is displayed.   To add a new group/Type allocation, specify A on the 
Options line.  To delete an existing group/Type from the list, specify D in the Cmd 
column.

At the point in time where you have decided to remove a group/Type from your 
project, SCLM Suite Administrator Workbench displays a Confirmation panel.  This 
panel asks whether you want to confirm the deletion of the specified group/Type and 
any group/Type combinations that promote to it.  You must respond positively to this 
Confirmation panel to have the delete take effect.  On this Confirmation panel, you 
can choose to delete any data associated with the group/Types you are deleting by 
placing an S or slash (/) on the appropriate line. Note that this behavior  differs when 
you take similar actions using the workstation interface.  When using the workstation, 
you are asked to confirm the deletion of the object and the deletion of associated data 
from the Group, Type, and Group/Type dialogs.
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By default, more space is allocated at the top of a given hierarchy, with less space 
allocated to the lower nodes, since SCLM only draws down to lower nodes what is 
absolutely necessary to accomplish the task.  Unless overridden, the topmost 
group/Type data sets' space allocation is based on the information you provided in 
the Edit SCLM Type entry panel, with space allocated to permit growth to twice the 
initial size.  The group/Type data sets lower in the hierarchy are allocated a small 
initial space, with room to grow to twice the initial size of the topmost equivalent 
group/Type data set.  You can specify that a given group/Type data set is not to be 
allocated by leaving its Allocate column blank. 

Overriding default allocations

Use the Group/Type Parameters panel to override default allocations for a 
group/Type.  

On this panel:

1. Specify the allocation units—Tracks, Cylinders,  or Blocks

2. Specify the number of primary  and secondary allocation units

3. Place a slash (/) on the appropriate lines to specify:

• Whether versioning is active for this group/Type by indicating that a Version 
Data Set is to be allocated. If you specify that versioning is active, then an 
Audit Data Set is automatically specified for you by SCLM Suite 
Administrator Workbench.

• Whether auditing is active for this group/Type. If you checked Version Data 
Sets to indicate that versioning is active, then Audit Data Sets are 
automatically specified by SCLM Suite Administrator Workbench.

4. Place a slash (/) on the Check Sum line to indicate that checksum verification is to 
be performed upon retrieval of an SCLM version.

5. Specify the number of versions to be retained. When the number you have 
specified is reached, the latest version is kept and the earliest version is discarded.  

6. Specify the sequence number type which may be  STANDARD, STD, COBOL, or 
NONE.  NONE is the default. 

Specifying User Exit information

Pressing Enter on the Group/Type Parameters panel takes you to the Selected User 
Exit panel. Use the  Selected User Exit panel to select user exits to work with.  If Breeze 
is installed, the name of the data set containing the Breeze user exits is displayed at 
the top of the panel.  Specify A on the Option line to add default user exits to this 
Selected User Exits panel. Specify B on the Option line to add the Breeze user exits. 

On this panel, you can specify E on the Cmd line to edit information about an exit.   
Specify V to view information about an exit, or D to delete an exit. Once you have 
filled in the Cmd lines for the exits you want to work with, press Enter.  For each exit 
you want to configure, SCLM Suite Administrator Workbench displays the User Exit 
Detail Specification panel.  On this panel:  

1. Specify the module name where the exit code is stored

2. Specify the Load Data Set name that contains the module

3. Select the Exit invocation method—linked, attached, invoked by TSO, or called 
through ISPF services 

4.  Specify the option list to be passed to the user exit routine.  You can specify a 
maximum of 256 characters, including delimiters, for the options. Enclose the 
option string in parentheses or single quotes.
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When you have completed this panel for a given exit, press Enter.  The panel is 
displayed sequentially for each exit you chose to configure on the User Exit panel.

Creating language definitions

Pressing Enter on the  Selected User Exits panel or the User Exit Detail Specification 
panel takes you to the Language Definition Wizard so that you can create Language 
Definitions. See Chapter 6, “Using the Language Definition Wizard,” on page 37.  

Completing the project definition and building the project

Once you have completed language definition activities, you have  viewed all of the 
panels that comprise the project you wanted to define or modify.  You can return to 
any of the panels in the project definition and modify them if you wish.  Once all of 
your desired modifications have been made,  SCLM Suite Administrator Workbench 
displays the Build Project panel. There, you can choose to view the source code for 
your project or immediately perform the build. 

If you choose to view the project source,  SCLM Suite Administrator Workbench 
displays it for you.  If  you choose to perform the build, SCLM Suite Administrator 
Workbench performs any requested data set deletions or allocations, and assembles 
and link edits the project definition.  If you type OUTPUT on the Option line,  SCLM 
Suite Administrator Workbench displays the output of the last script you have run. 

If the build ran successfully, the project is now ready for use.  If the SCLM Suite 
Administrator Workbench displayed any errors, you will need to identify and correct 
the problems before attempting the rebuild again.

Once the project has been successfully built, the SCLM Suite Administrator 
Workbench returns you to the project list.

If you are building or rebuilding a project and an error occurs, a file called 
error.number.tar is created.  Save this file and call your support person.  You can also 
review the contents of the file by entering TAR on the UNIX System Services 
command line.  

If  your project fails to build...

If your project fails to build: 

• Ensure that you have defined at least one group and one Type for your project.

• Ensure that there are no loops in your promote hierarchy.  Thus, for example, you 
cannot define a promote sequence that has Group A promoting to Group B, 
promoting to Group C, which promotes back to Group A.

• Similarly, you must ensure that there are no loops when you define your 
authorization groups.  An example of what to avoid is the case where 
authorization group AGRP1 contains authorization codes A, B, C, AGRP2, and 
authorization group AGRP2 contains authorization codes A, B, D, AGRP1. 

If you type  SLOG on the Option line of the Project List panel, the VSAM Maintenance 
panel, or the Build Project panel, SCLM Suite Administrator Workbench displays a 
log of actions related to the script you have just run.
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Chapter 6. Using the Language Definition Wizard

In the course of defining a new SCLM project or modifying an existing project, you 
may wish to add a new language definition or modify an existing definition.  To do so,  
use the SCLM Suite Administrator Workbench-provided Language Definition 
Wizard.

During the initial language definition and at any time after you have defined the new 
language,  you can  modify its definition by accessing the Language Definition Wizard 
and making and saving any changes.  Having completed the language definition, you 
can return to the  Project Wizard to complete your project definition or modification.

From the workstation

Selecting the Language Definition tab at the bottom of a panel display takes you to 
the Language Definition Wizard.   SCLM associates a language with each member to 
define the way in which that member will be processed during an edit, build, or 
promote. The language definition determines the parser to be invoked when a 
member is created or updated, and the translator to be invoked during a build.

On the Wizard panels, the name of the SCLM macro that contains the keywords you 
will specify is listed in parentheses. To find out more about these SCLM macros, refer 
to the IBM z/OS ISPF SCLM Reference manual.

Proceed through the pages of the Wizard by completing each page and then pressing 
Next. When you have completed your work, press Finish to save your work and exit 
the Wizard.  At any time before finishing your work, you can press the Back button to 
return to  a previous page of the Wizard.

Language definitions

The Language Definition page displays a line for each language definition that is 
currently defined for your project. The display box shows the logical name for the 
language definition in the Name column. This is the name you specify using the 
Language field of this Wizard and is the name used by the FLMLANGL macro to 
identify the definition. The physical name by which this language is identified is 
shown in the Copybook column in the display box. This field displays a member 
name where the language definition resides. This member resides in the data set you 
have defined as SYSLIB1 on the Default Data Sets panel.  

Use the Language Definition page to add a new language definition, or edit or remove 
an existing language definition. To add a new language definition, click Add.   SCLM 
Suite Administrator Workbench displays the Language Definition Wizard. To edit an 
existing language definition, click its name in the display box, then click Edit to 
display the Language Definition Wizard. To remove a language definition, click its 
name in the display box, then click Remove.

Language Definition Wizard--selecting the method of creation

The Language Definition Wizard assists you in creating a language definition from an 
existing data set or existing JCL, or creating one from scratch. When you are adding a 
new language definition, the first page of the Wizard permits you to select a radio 
button that specifies the method you will use to create the new definition. If you have 
chosen to create your new definition from either an existing data set or existing JCL 
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member, SCLM Suite Administrator Workbench provides you with a panel on which 
you can browse for the source data set and member that contains the model 
definition. This panel is not displayed if you want to create a language definition from 
scratch. Your path through the wizard will be the same for Create from a data 
set/Create from JCL or Create from scratch, with the exception of this data set 
selection panel. Click Next to continue.

Selecting a data set and member

If you are creating a definition from an existing data set member or  from JCL, you can 
type the name of the data set in the display box or browse for the data set name. To 
browse, you must provide a qualifier, which, together with an asterisk, displays a list 
of data sets that meet this search criterion. Once you have typed in or selected a data 
set, a list of that data set’s members is displayed in the Member Name box. Select the 
member you want to use, then click Next. 

Defining language identifiers and creating rebuild groups

Clicking Next displays the page of the Wizard on which you can define a language to 
SCLM by specifying the name of the language and processing characteristics using 
the keywords supported by SCLM macro FLMLANGL.  Specify:

• A name of up to 8 characters for this language definition 

• A member name of up to 8 characters where the language definition will reside. 
This member resides in the data set you have defined as SYSLIB1 on the Default 
Data Sets dialog. 

• A version name of up to 8 characters for this language. If you change this 
keyword, all source members under this language will be rebuilt. 

• A value (buffer size) representing the memory required to hold the expected 
number of $list_info records SCLM allocates for a parse, verify, build, copy, or 
purge translator. The translator returns dependency information in the allocated 
memory. 

• Whether or not the System Library is to be checked to determine whether an 
include is to be tracked, and if so, when. Checking may occur at either parse or 
build time, or not at all. 

• Whether or not System Library data sets are to be allocated for IOTYPE I 

• Whether this language can be assigned to editable members 

• Whether dependents of this member are to be rebuilt when some outputs from 
the translator for this member were not saved. 

The display box at the bottom of this panel displays the Rebuild Groups as defined by 
SCLM macro FLMLRBLD. The FLMLRBLD macro causes members with a particular 
language to be rebuilt whenever they are promoted into particular groups. Using the 
buttons at the bottom of this display box, you can Add a new rebuild group, or Edit or 
Remove an existing rebuild group from the list.

Clicking Add or Edit causes SCLM Suite Administrator Workbench to display the 
Rebuild dialog. On this dialog, you can move one or multiple groups from a list of 
available groups to a list of selected groups, and vice versa, using the arrows 
provided.

Providing Include and SYSLIB parameters

Clicking Next displays the page of the Wizard on which you can view a list of existing 
Include Set and System Library definitions. You can add objects to these lists or 
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remove objects from them. Clicking the Add button under either display box places 
your cursor on a new line in the box on which you can type information for each 
column. Selecting a row and clicking Remove  removes that row from the display box. 

Clicking Add under the Include Set Definitions display box permits you to define: 

• The name of an include set. An include set name can only be used once per 
language definition. 

• A list of Types that contain the includes for the include set. Two SCLM variables, 
@@FLMTYP and @@FLMETP, can be used in this Types list.

• Whether (Y) or not (N) SCLM is to process the includes of an included member 
when the language of the included member differs from that of the source 
member; that is, whether or not language boundaries are crossed. 

Clicking Add  under the System Library Definitions display box permits you to 
define: 

• The name of a partitioned data set that contains macros or includes from outside 
the project. The data set name must meet MVS data set naming requirements. 

• The name of an include set on an FLMINCLS macro (as in the list at the top of the 
panel). 

• The serial number of a direct access volume on which the data set is located.

Defining translator parameters 

Click Next  to display the Translator Parameters panel. This Wizard panel assists you 
in defining your translator and allocating data sets for use by the translator.

In the Translator Definition area of this panel, you can provide the following 
information:

• The function, listed in the drop-down box, that this translator will provide. Valid 
values are:

Parse to gather statistics and dependencies

Verify
to perform validation

Build to assemble, compile, link, or otherwise process a member so that the 
outputs have different formats than the inputs

Copy invoked when a Promote copies an SCLM-controlled member to the next 
higher group in the hierarchy 

Purge
to purge data that is related to an SCLM-controlled member, but the data 
is not under SCLM control

• The call name, which is a name of up to 16 characters for this translator. This 
name appears in SCLM messages along with translator return codes. The name 
may contain blanks if you enclose the entire name in single quotes. 

• The method by which the translator is called: ATTACH, LINK, TSOLNK, or 
ISPLNK

• The name of the program, listed in the drop-down box, that will be invoked by 
the translator. Normally, this program would be a parser, compiler, assembler, or 
user-supplied routine. If you selected a call method of ATTACH, LINK, or 
TSOLNK, this is the name of a REXX Exec or CLIST, or the entry point to a load 
module. If you selected ISPLNK, this value must be SELECT. 

• The step label, which identifies the job step label for this translator. 
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• An acceptable return code from the translator. This is a positive integer or zero. If 
the translator returns a return code value greater than the value you specify, the 
process has failed and no accounting information is saved in the hierarchy. 

• An integer from 0 through 3, selected from a drop-down box, that indicates the 
parameter order to the translator. The default is 1. These integers have the 
following meaning: 

— 0    No parameters are to be passed 

— 1    Option list is to be passed 

— 2    ddname substitution list is to be passed 

— 3    Option list is to be passed followed by the ddname substitution list

• A keyword to be used in architecture members to specify additional options for 
this translator. 

• A ddname for the task library. This ddname is associated with one or more data 
sets that contain the translator load module. This value is only valid when the call 
method is ATTACH. 

• A data set name of up to 44 characters in length, for the data set containing the 
translator load module (COMPILE parameter) or REXX Exec being invoked. This 
parameter is not required with the translator load module that resides in the 
system concatenation. 

• Whether or not the input members for this translator reside in SCLM-controlled 
partitioned data sets. If this checkbox is checked, this statement is true. If this 
checkbox is not checked, the default varies according to the translator's function 
type. If you specify multiple translators for this language definition, this value 
must be the same for all of them. 

• A list of options, separated by commas, that you enter in the text box. This options 
list is passed to the program whose name you specified in the COMPILE 
parameter. The maximum length of the list, including delimiters, is 255 
characters. The options you pass must be acceptable to the program. Delimit the 
list with single quotes or parentheses. The options can also contain variables to 
provide dynamic information to the COMPILE program. The @@FLMMBR and 
@@FLMTYPE variables will be replaced with the name of the member and type of 
the last SINC, INCL, or INCLD statement in the architecture definition. If a source 
member is being built, the variable will be replaced with the name of the source 
member.

Once you have completed this area of the Wizard panel, you can select the 
FLMTCOND button to display the Condition dialog (see “The Condition dialog” on 
page 41).  If the function of this translator is build, you can also select the FLMTOPTS 
button to display the Options dialog (see “The Options dialog” on page 41).  

The Allocations area of this panel displays: 

• The IOTYPE, which can be A, I, L, N, O, P, S, U, and W. 

• The ddname to be used for the specified IOTYPE for this allocation definition. 

You can Add or Edit  allocations by clicking the appropriate button below the display 
box. This results in displaying the Allocation dialog (see“The Allocation dialog” on 
page 41). You can also remove an allocation from the list using the Remove button. 

The Condition dialog, the Options dialog, and the Allocation dialog each return you 
to this Translator Parameters panel.  When you have completed the Translator 
Parameters panel, click Next to finish your work on this language definition.
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The Condition dialog

Use the Condition dialog to specify whether a Build translator is to be run or skipped 
based upon the group at which the build takes place and return codes from previous 
Build translators in the same language definition. You can specify: 

• Whether the conditions you specify are valid for all groups, only the groups you 
select from the display box, or only the groups you do not select from the display 
box 

• The name of the translator to be run, as selected from the pull-down box 

• The value of the return code that must be matched to make the condition true 

• Whether the translator is to be run or skipped when the condition evaluates true 

The Options dialog

The Options dialog is applicable only to Build translators and permits you to specify 
one or more option lists that are used to vary the options passed to a Build translator. 
Valid entries on this dialog are: 

• The text of the options to be passed

• Whether the criteria you specify are valid for all groups, only the groups you 
select from the display box, or only the groups you do not select from the display 
box 

• Whether this options list is to replace an existing options list, or whether it is to be 
appended to an existing options list 

The Allocation dialog

Use the Allocation dialog to allocate permanent or temporary data sets used by the 
translators. The top portion of the Allocations dialog permits you to specify allocation 
parameters for the translator. Use this portion of the dialog to: 

• Select from the pull-down list the IOTYPE  for this allocation. Valid IOTYPEs are 
A, I, L, N, O, P, S, U, and W. 

• Specify the ddname to be used for this allocation. 

• Specify a reference to a keyword in the build map or architecture definition. This 
keyword are used by other parameters in this macro. 

• Specify the disposition to be used for this allocation on a JCL DD statement. Valid 
values are OLD, SHR, MOD, or NEW. If Disposition is not specified, it defaults 
to an appropriate value for the IOTYPE parameter. 

• Select from the pull-down list the default SCLM Type for this allocation. 

• Specify the default member name for the output member. 

• Specify the record format, which may be F, FA, FM, FB, FBA, FBM, V, VA, VM, 
VB, VBA, VBM, and U. 

• Specify the block size of the data set. This parameter is valid for IOTYPEs W, O, P, 
and S. 

• Specify the logical record length of the data set (numeric). This value is valid for 
IOTYPEs W, O, P, and S. The default is 80. 

• Specify the number of records to be allocated (numeric). This value is valid for 
IOTYPEs W, O, P, and S. The default is 500. 
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• Specify the number of directory blocks allocated to a partitioned data set. The 
default is 1. If the data set is not partitioned, the default is 0. SCLM ignores 
nonzero values except when the data set is partitioned. 

• Specify the language to be used when you want the build output of one language 
definition to be verified, built, copied, or purged in another language definition. 

• Select from the drop-down box the name of an FLMINCLS macro in the language 
definition that lists the types to be allocated. This parameter is only valid for 
IOTYPE I. If INCLS is not specified, the default include set is used to determine 
the types for allocation.  

• Select from the Print  drop-down box a value to determine whether you will copy 
the contents of a sequential data set to the SCLM listings data set 
(userid.BUILD.LISTxx). This parameter is only valid for data sets allocated with 
IOTYPE W, S, or O. The valid values are: 

— N   indicating that the contents of the temporary sequential data set are not to 
be copied to the listings data set. 

— Y   indicating that the contents of the temporary sequential data set are to be 
copied to the listings data set. 

— I   indicating that the contents of the temporary sequential data set are to be 
copied to the listings data set. SCLM will open and close the temporary data 
set before invoking the translator. 

• Specify whether a temporary partitioned data set is to be allocated as a PDS or 
PDSE. This parameter is valid only for IOTYPE P. 

• Specify a ddname that is to be allocated to a member of a temporary PDS created 
by SCLM. The MEMBER parameter is valid only for data sets allocated as 
IOTYPE P. You may use the SCLM variables @@FLMONM or @@FLMMBR in this 
text box to represent the member name. 

• Specify a return code value that will be set by a translator that, if matched, 
indicates that SCLM is not to store a translator's output in this data set. This 
parameter is valid only for IOTYPEs O and P. 

• Place a check in the Catalog checkbox to indicate that this data set is to be 
catalogued. If you check this box, SCLM temporarily allocates cataloged data sets 
with a predefined high-level qualifier, the TSO-prefix, and deletes the data set 
after all translators complete their functions. 

• In the DINIT checkbox, specify that SCLM is to create a member in a temporary 
data set that has been allocated with IOTYPE P. If you check the DINIT checkbox, 
the member that was created is initialized with a single record containing the 
string DUMMY FILE. If the IOTYPE is other than P, a check in this checkbox will 
be ignored. The member that is created will have the same name as the build map 
created if the translator is successful, unless you have specified another name 
using the MEMBER parameter. In the latter case, the value you specified in the 
MEMBER parameter will be used to determine the name of the member to be 
initialized.

• In the MALLOC checkbox, identify the case where the translator will generate a 
sequential output data set having a specific data set name and the data set cannot 
be allocated to a ddname before the translator is invoked. This parameter is valid 
only for IOTYPEs O and A. If you check the MALLOC checkbox, you must also: 

— Define an FLMCPYLB macro that identifies the name of the data set to be 
allocated 

— Specify a value for the KEYREF parameter on the FLMALLOC macro 

— Leave the ddname parameter blank 
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• Specify that SCLM is to delete all data sets referenced by this FLMALLOC macro 
when SCLM has finished processing them. If you check this ALLCDEL checkbox,  
you must also check the MALLOC checkbox. 

• Specify that the data set is always to be allocated using VIO. If you do not check 
the VIO checkbox, the data set will always be allocated without VIO. 

Use the  Copylib portion on the lower portion of the Allocation dialog to allocate a 
data set to a ddname.  You can Add or Remove copy library definitions for copy 
libraries to be associated with this allocation. The FLMCPYLB macro lists a ddname 
for this allocation (optional) and the name of a data set to be allocated by this 
allocation. If you specify more than one copy library, SCLM concatenates the data sets 
in the order they are specified. Data set names can contain the following variables: 

• @@FLMDBQ 

• @@FLMSRF

• @@FLMPRJ 

• @@FLMALT 

• @@FLMUID 

• @@FLMGRP 

• @@FLMGRB 

• @@FLMMBR 

• @@FLMTYP  

• @@FLMDSN

The specified data set name, or the data set name that results after substitution occurs 
for any SCLM variables, must meet all of the requirements of MVS data set names. 
That is, you may specify a data set name of up to 54 characters, including periods and 
parentheses, when a member name is specified, or a name of up to 44 characters when 
no member name is specified.

Finish language definition

On the final page of the Wizard, a display box shows the translators that have been 
defined for this language definition. You can move translators Up or Down in the 
displayed list by clicking the appropriate button. Similarly, you can Add translators to 
the list, or Edit or Remove existing translators from the list. When you have 
completed your work with the current language definition, click Finish to save your 
work.

From an ISPF session

On the Language  Definition Specification panel, specify one of the following options 
on the Enter Option line:

• Option 1 displays a list of the project’s language definitions. 

• Option 2 permits  you to enter a new language definition from scratch.

• Option 3 permits you to create a new language definition from a data set.  
Specifying option 3 and a name of up to 8 characters for the new language 
definition, then pressing Enter, displays the Create Language Definition from 
Data Set panel. 

• Option 4 permits you to create a new language definition from JCL. Specifying 
option 4 and a name of up to 8 characters for the new language definition, then 
pressing Enter, displays the Create Language Definition from JCL  panel. 
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If you are creating a new language definition, enter its name of up to 8 characters in 
the field New Language Definition Name.

Working with the Language Definition Listing

Use the Language Definition Listing panel to view, edit, or delete language definitions 
from your project.  You can view a language definition  by entering V on the line 
preceding its name.  You can edit a language definition by entering E.  Press Enter to 
process your choices.  In either case, the Language Definition Wizard displays an ISPF 
Edit panel,  with the language definition you selected filled in. Note that you can 
update this information only if you accessed this panel using an Edit (E) request.

You can also use the Language Definition Listing panel to delete a language definition 
or multiple definitions from your project  by entering D in front of the definitions to 
be deleted.  Once you have confirmed your choice to delete a definition or definitions,  
SCLM Suite Administrator Workbench removes these from the list of language 
definitions associated with your project.

Entering a language definition from scratch

If you select option 2 from the Language Definition Specification Menu, SCLM Suite 
Administrator Workbench displays an ISPF editor panel.  Type in your new language 
definition.  Press PF3 to save your work and exit language definition.

Creating a language definition from a data set

If you select option 3 from the Language Definition Specification Menu, SCLM Suite 
Administrator Workbench displays the Create Language Definition from Data Set 
panel.  On this panel, you can specify the name of the data set and member that 
contain the model language definition.  To browse for a data set, press PFnn in the 
Enter source data set  field.  SCLM Suite Administrator Workbench displays a data set 
list from which you can select the data set you want to work with.  

Specify the name of a member from this data set in the Enter source member field.  If 
you want to browse for a member name, press PFnn. When the list of members is 
displayed, select the one you want by typing an S or a slash (/) on the line in front of 
the member. The data set member you selected is displayed in the Language 
Definition Editor.  Make any necessary changes and press Enter to save your work.

Creating a language definition from JCL

If you selected option 4 from the Language Definition Specification Menu,  SCLM 
Suite Administrator Workbench displays the Create Language Definition from JCL  
panel. To browse for a JCL data set, press PFnn  in the Enter source data set  field.  
SCLM Suite Administrator Workbench displays a data set list from which you can 
select the data set you want to work with. 

Enter the name of a JCL member from this data set in the Enter source member field.  
If you want to browse for a member name, press PFnn. The JCL member you selected 
is displayed in the Language Definition Editor.  Make any necessary changes and 
press Enter to save your work. There are some special considerations that must be 
taken into account when creating a language definition from JCL.  See 
“Considerations when creating a language definition from JCL” on page 45 for further 
information.
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Considerations when creating a language definition from JCL

When creating language definitions from JCL, whether from the workstation or using 
the ISPF interface, you should select a job that meets the following criteria, or you 
may copy and modify an existing job to meet these criteria. Each step that executes a 
program in a job will create a FLMTRNSL step in the language definition.  Since 
certain parameters cannot be determined from the JCL, the generated language 
definition may require some hand tailoring before  the JCL can be used successfully in 
your SCLM project. These criteria are:

• A JOB statement should span three lines; for example:

//JOBNAME  JOB 01,

//  'Text',

//  CLASS=A,

//  MSGCLASS=8

• The job should only compile or link a single program, otherwise the generated 
language definition will require excessive tailoring.

• Jobs may execute PROCs - either inline or from a PROC library.

The job is modified as follows and copied into <PROJECT>.PROJDEFS.JCL:

• Change the job name to user id + 'A'.

• Add TYPRUN=SCAN to the JOB statement.

The job is submitted and the output retrieved to parse the JCL into a language 
definition using the actual data set names and other parameters that were substituted 
during the TYPRUN=SCAN operation.

When converting a job into a language definition, SCLM Suite Administrator 
Workbench uses the following rules:

1. A FLMLANGL macro is generated.

2. A FLMTRNSL macro is generated for the parser.

3. For each step executing a program, an FLMTRNSL macro is generated.

4. For each dataset allocated to SYSLIB, FLMSYSLB and FLMCPYLB are generated.

5. An FLMINCLS is generated for each.

6. The type of FLMALLOC depends on the DDNAME and the program being 
executed.

7. Where parameters cannot be determined, AUZ????? Is placed in the source.

Note:  the generated language definition will need hand tailoring.
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The next sections contain a sample job and the pre-tailoring language definition that 
was generated.

Sample Job:

//MDDECRB  JOB 01,  
//           'CHRIS BAILEY',  
//           CLASS=A,    
//           MSGCLASS=8, 
//           NOTIFY=&SYSUID,  
//           USER=,GROUP=,PASSWORD=  
//*
//* COPYRIGHT (C) 2002, ROCKET SOFTWARE, INC.. ALL RIGHTS RESERVED.   
//*
//*
//ASMNRENT PROC MEM='',   
//           OBJ='MDTECRB.PROJDEFS.OBJ',     
//           SOURCE='MDTECRB.PROJDEFS.SOURCE'        
//ASM      EXEC PGM=ASMA90,     
             REGION=2048K,
//           PARM='LINECOUNT(52),OPTABLE(ESA),TEST'   
//SYSLIB   DD  DSN=SYS1.MACLIB,  
//           DISP=SHR       
//         DD  DSN=SYS1.AMODGEN,   
//           DISP=SHR    
//         DD  DSN=CEE.SCEEMAC,    
//           DISP=SHR      
//         DD  DSN=ISP.SISPMACS,   
//           DISP=SHR  
//         DD  DSN=&SOURCE,         
//           DISP=SHR   
//SYSIN    DD DSN=&SOURCE(&MEM),     
//           DISP=SHR        
//SYSUT1   DD DSN=&SYSUT1,             
//           UNIT=(SYSDA,SEP=SYSLIB),                                                         

//           SPACE=(CYL,(10,5))  
//SYSPUNCH DD DSN=&OBJ(&MEM),   
//           DISP=SHR     
//SYSPRINT DD SYSOUT=* 
//SYSLIN   DD DSN=&OBJ(&MEM), 
//           DISP=SHR     
//       PEND     
//*   
//MDTECRB  EXEC ASMNRENT,MEM=MDTECRB 
//*     
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Generated language definition:

         FLMLANGL  LANG=ASM,
               ALCSYSLB=Y,
               BUFSIZE=1000,
               CANEDIT=Y,
               CHKSYSLB=IGNORE,
               VERSION=JCL2LDML
ASM      FLMSYSLB  SYS1.MACLIB
         FLMSYSLB  SYS1.AMODGEN
         FLMSYSLB  CEE.SCEEMAC
         FLMSYSLB  ISP.SISPMACS
         FLMSYSLB  MDTECRB.PROJDEFS.SOURCE
         FLMINCLS  TYPES=(@@FLMTYP,
               @@FLMETP),
               CROSLANG=Y
AUZINC01 FLMINCLS  TYPES=(@@FLMTYP,
               @@FLMETP),
               CROSLANG=Y
         FLMTRNSL                 CALLNAM='AUZ?????',
               FUNCTN=PARSE,
               COMPILE=FLMLPGEN,
               OPTIONS=(SOURCEDD=SOURCE,
               PARSEDSN=''@@FLMDSN'',
               PARSEMEM=@@FLMMBR,
               STATINFO=@@FLMSTP,
               LISTINFO=@@FLMLIS,
               LISTSIZE=@@FLMSIZ),
               PORDER=1
         FLMALLOC                 IOTYPE=A,
               DDNAME=SOURCE
         FLMCPYLB @@FLMDSN(@@FLMMBR)
         FLMTRNSL                 CALLNAM='ASMA90',
               FUNCTN=BUILD,
               COMPILE=ASMA90,
               GOODRC=0,
               OPTIONS='LINECOUNT(52),OPTABLE(ESA),TEST',
               PORDER=1
FLMALLOC                 IOTYPE=I,
               DDNAME=AUZ?????,
               KEYREF=SINC,
               INCLS=AUZINC01
         FLMALLOC                 IOTYPE=I,
               DDNAME=SYSLIB,
               DISP=SHR,
               KEYREF=SINC
         FLMCPYLB SYS1.MACLIB
         FLMCPYLB SYS1.AMODGEN
         FLMCPYLB CEE.SCEEMAC
         FLMCPYLB ISP.SISPMACS
         FLMCPYLB MDTECRB.PROJDEFS.SOURCE
         FLMALLOC                 IOTYPE=S,
               DDNAME=SYSIN,
               KEYREF=SINC,
               RECNUM=20000
         FLMALLOC                 IOTYPE=W,
               DDNAME=SYSUT1,
               RECNUM=20000
         FLMALLOC                 IOTYPE=O,
               DDNAME=SYSPUNCH,
               DFLTTYP=OBJ,
               KEYREF=OBJ,
               RECNUM=20000
 Chapter 6.   Using the Language Definition Wizard  47



 

                  FLMALLOC                 IOTYPE=O,
               DDNAME=SYSPRINT,
               DFLTTYP=LIST,
               KEYREF=LIST,
               PRINT=Y,
               RECNUM=20000
         FLMALLOC                 IOTYPE=O,
               DDNAME=SYSLIN,
               DFLTTYP=OBJ,
               KEYREF=OBJ,
               RECNUM=20000
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Chapter 7. Deleting a Project or Other SCLM Objects

As you use SCLM Suite Administrator Workbench, adding or modifying an SCLM  
project or other SCLM objects, you will have the opportunity to delete project or 
profile objects or the project itself.  A complete discussion of deleting these objects is 
provided in various chapters of this book. This chapter provides a summary of the 
processes required to delete various SCLM objects.

From the workstation

This unit describes methods for using the workstation interface to delete a project or 
other SCLM objects.

Deleting a project

From the SCLM pulldown in your workspace:

1. Click Delete Project in the pulldown menu.  

2. From the pop-up that displays, place a check in the check box provided if you 
want to delete the project’s data in addition to deleting the project.

3. Click Yes to confirm deletion of the project, and if appropriate, its associated data.  
Click No to cancel the deletion.

You can also choose to delete a project by right-clicking its name in the Navigator tree 
and then selecting Delete Project from the pop-up menu.  In this case, you cannot 
choose to delete the associated data.  From the pop-up that displays, click Yes to 
confirm deletion of the project.  Click No to cancel the deletion. 

Deleting a Type 

To delete a Type from your profile:

1. Access the Default Types Preference page by selecting the Window pulldown in 
your SCLM workspace.  From the pulldown, select  Preferences > SCLM Admin 
Workbench >Default Types Preference Page.

2. Click the name of the Type you want to remove in the Default Types list  box and 
press the Remove button. 

To delete a Type from your project:

1. Access the Types page by clicking the Types tab at the bottom of any Project 
Wizard panel.

2. Click the name of the Type you want to remove from your project by clicking its 
name in the Selected Types list box.

3. Click the left-pointing arrow (<) to move the selected Type to the Default Types 
list box.  This removes the selected Type from your project, but does not delete it 
from the list of default Types available to be used in a project.  When you choose 
to remove a Type from your project: 

• The Project Wizard  asks you to confirm the deletion of the Type. If you select 
the No button, no action is taken.

• If you select the Yes button, then the Wizard asks whether you want to also 
delete the data associated with this Type.  If you select No,  then only the Type 
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is deleted.  If  you select Yes, then the Type and any associated data sets for 
this Type are deleted.

Deleting an authorization group or authorization code

To delete an authorization group or authorization code from your project: 

1. Access the Authorizations page by clicking the Authorizations tab at the bottom 
of any Project Wizard page.  

2. Click the names of the authorization codes or authorization groups to be removed 
in either the Authorization Group or Authorization Code list box.

3. Click Remove.  If you remove an authorization group, any dependent 
authorization codes are also removed. 

Deleting a group

To delete a group from your project;

1. Access the Groups page by clicking the Groups tab at the bottom of any Project 
Wizard page. 

2. Click the group’s icon, then click Remove. 

3. When you choose to remove a group from your project: 

• The Project Wizard  asks you to confirm the deletion of the group. If you 
select the No button, no action is taken.

• If you select the Yes button, then the Wizard asks whether you want to also 
delete the data associated with this group.  If you select No,  then only the 
group is deleted.  If  you select Yes, then the group and any associated data 
sets for this group are deleted.

If you delete a group that has groups in the project hierarchy that are subordinate to it, 
these groups are also removed.

Deleting a language definition

To remove a language definition from your project:

1. Access the Language Definition Wizard by clicking the Language Definition tab 
from any Project Wizard page. 

2. From the list of existing language definitions that the Language Definition Wizard 
displays, click the name or names of those to be removed, then click the Remove 
button.

From an ISPF session

This unit describes methods for using the ISPF interface to delete a project or other 
SCLM objects.

Deleting a project

To delete a project:

1. From the SCLM Suite Administrator Workbench Project Administration Main 
Menu, specify option 3 — List on the Command line.

2. SCLM Suite Administrator Workbench displays the Project List. 
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3. Place a D on the line next to the project or projects  to be deleted and press Enter.

Deleting a Type

To delete a Type from your profile: 

1. Access the Edit Default Type List panel.

2. Place a D on the line preceding the Type or Types you want to delete and press 
Enter.

To delete a Type from your project:

1. Access the Select Types panel.

2. Place a D on the line preceding the Type or Types you want to delete and press 
Enter. 

Deleting an authorization group or authorization code

To delete an authorization group or groups from your project:

1. Access the Authorization Group List panel.

2. Place a D on the line preceding the authorization group or groups you want to 
delete and press Enter. This action deletes the specified authorization groups and 
any dependent authorization codes from your project.

Deleting a group

To delete a group or groups from your project:

1. Access the Group List panel. 

2. Place a D on the line preceding the group or groups you want to delete and press 
Enter. Note that, if you delete a group that has groups in the project hierarchy that 
are subordinate to it, these groups are also deleted.

Deleting a language definition

From the SCLM Suite Administrator Workbench Language Definition Wizard Main 
Menu:

1. Type option 1 — List on the Command line. The wizard displays the Language 
Definition List panel.

2. Place a D on the line or lines preceding the names of the language definitions you 
want to delete and press Enter.
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Chapter 8. Cloning an Existing Project

This chapter describes the process to clone an existing project.

When cloning a project, all references in the project that match the project name are 
replaced by the new project name. If you are generating an alternate project, all fields 
that refer to the project member name are replaced by the new alternate name. When 
cloning a project and including the project data, all project data sets with the 
exception of accounting, auditing, settings, and versioning data sets, are copied. 
During the creation of the necessary scripts to perform the copy, SCLM Suite 
Administrator Workbench checks to ensure that the target data set name is different 
from the source. If a copy operation attempts to copy a data set to itself, the project 
settings are cloned, but the data will not be cloned.

From the workstation

From the SCLM pull-down at the top of your workspace, click Clone SCLM Project.  
SCLM Suite Administrator Workbench displays the Clone SCLM Project dialog with 
the name of the project that you are cloning filled into the Cloning Project Name text 
box.  The value in this box cannot be modified. 

1. In the New Project Name text box of this dialog, specify a name of up to 8 
characters for the new project.

2. If this is an alternate project, place a check in the appropriate check box and 
specify a name for the alternate project in the New Alternate Name text box.

3. To include data from this project in the cloned project, place a check in the 
appropriate check box.

4. To complete your work and save the cloned project, press OK. To cancel your 
work without saving the cloned project, press Cancel.

From an ISPF session

To clone a project:

1. From the SCLM Suite Administrator Workbench Project Administration Main 
Menu, specify option 3 — List on the Command line.

2. SCLM Suite Administrator Workbench displays the Project List. 

3. Place a C on the line next to the project or projects  to be cloned and press Enter.

4. Specify a name of up to 8 characters for either the new project or the alternate 
project, if this is an alternate. 

5. If you want to include project data from the cloned project in the clone, type a 
slash (/) on the Do you wish to include data with clone?  line.

6. Press Enter to save your responses.  SCLM Suite Administrator Workbench places  
you in the Project Wizard, with values populated from the source project. 
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Chapter 9. Migrating Software Assets into your Project

Use SCLM Suite Administrator Workbench's Migration Wizard to  migrate a data set 
member or group of members into your SCLM project and place them under SCLM 
control. As data is entered in the wizard, the values are saved on the host system, so 
that if you end the wizard session before all data is entered, you can resume your 
work in another session.

The Migration Wizard copies the selected assets into the target SCLM-managed 
library, updates the accounting file, and displays the migration report.

From the workstation

On the first panel of the Migration Wizard, specify the name of the data set that 
contains the member or members you want to migrate into your SCLM project. SCLM 
Suite Administrator Workbench displays a list of the data set’s members, from which 
you can select the member or members to be migrated. Once you have made your 
selection, specify:

1. A name of up to 8 characters to identify the group into which the members you 
selected will be migrated

2. The Type into which the members you identified will be migrated

3. The language of the members

4. A change code of up to 8 characters to be added to the information obtained by 
parsing the members

5. An authorization code of up to 8 characters in length

6. The date and time to be assigned to all migrated members. The default is the 
current date and time.  If you specify a value for the date, then you must also 
specify a value for the time.

From a drop-down list box, select the processing mode which may be:

• Conditional

Migrate processing stops if an error occurs

• Unconditional

Migrate processing continues regardless of any errors

• Forced

A new account record is created for the specified member or members regardless 
of previous status

Once you are satisfied with your entries, clicking Finish saves your work and exits 
the wizard.

From an ISPF session

To migrate assets into  a project, 

1. From the SCLM Suite Administrator Workbench Project Administration Main 
Menu, specify option 3 — List on the Command line.

2. SCLM Suite Administrator Workbench displays the Project List. 
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3. Place an M on the line next to the project or projects  to be migrated and press 
Enter to display the Migrate Assets into Project panel.  On this panel, specify: 

a. The name of the data set from which assets are to be migrated

b. The name of the member from which assets are to be migrated

You may use an asterisk as a wild card to locate the appropriate data set and member. 
SCLM Suite Administrator Workbench now displays the Migration Options for 
Selected Members panel.  On that panel: enter the following information in the fields 
provided: 

1. A name of up to 8 characters to identify the group into which the members you 
selected will be migrated

2. The Type into which the members you identified will be migrated

3. The language of the members

4. An authorization code of up to 8 characters in length

5. A change code of up to 8 characters to be added to the information obtained by 
parsing the members

6. The mode for the migration:

• Conditional

Migrate processing stops if an error occurs

• Unconditional

Migrate processing continues regardless of any errors

• Forced

A new account record is created for the specified member or members 
regardless of previous status

7. The date and time to be assigned to all migrated members
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Chapter 10. Maintaining  the Project’s VSAM Files

This chapter describes the procedures to maintain your project’s VSAM files.  You 
may already have defined procedures or tasks, or you may need to create new tasks.  
When creating your VSAM maintenance REXX scripts, you must include a comment 
with the string VSAMTASK <description> somewhere in the script; for example: 

/* VSAMTASK: Copy sequential backup data set to Primary Accounting data set */

This permits SCLM Suite Administrator Workbench to expose for your use those 
scripts from the ISPSLIB library and the project JCL library that follow this 
convention. 

From the workstation

From the SCLM pull-down at the top of your workspace, click VSAM Maintenance 
Wizard.  SCLM Suite Administrator Workbench displays the VSAM Maintenance 
Wizard dialog 

• If you choose to edit, delete, or run a VSAM task, SCLM Suite Administrator 
Workbench displays a list of  existing tasks.  Click the appropriate radio button 
and then click Next. The Wizard displays a list of tasks from which you select the 
task to be run, edited, or deleted. To process your choice and exit the Wizard, 
press Finish.

• To create a new task, enter its name and description in the text boxes provided 
and press Next. The Wizard displays a panel on which you can define the task. 
When you have completed your definition, press Finish to save the task and exit 
the Wizard.

From an ISPF session

To perform VSAM file maintenance: 

1. From the SCLM Suite Administrator Workbench Project Administration Main 
Menu, specify option 3 — List on the Command line.

2. SCLM Suite Administrator Workbench displays the Project List. 

3. Place a V on the line next to the project or projects for which VSAM file 
maintenance is to be performed and press Enter. 

4. SCLM Suite Administrator Workbench displays a panel showing the currently-
defined VSAM file maintenance tasks and their descriptions. To create a new task, 
enter a task name of up to 8 characters and a text description for the new task.  
Then press Enter. 

5. To select an existing task to modify, enter a slash (/) on the line in front of the task.  
SCLM Suite Administrator Workbench displays the task in an editor so that you 
can make any required modifications.

Typing OUTPUT on the Option line displays the output of the last script you have 
run.
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Chapter 11. Using the Architecture Definition Wizard

SCLM uses architecture definitions to control the build and promotion processes.  
SCLM Suite Administrator Workbench recognizes four kinds of architecture 
definitions:

• High Level Architecture Definitions.  These are used to subset an application into 
sub- applications.  When used in a build or promote operation, all referenced 
architecture members are built or promoted.

• Linkage Editor Control Architecture Definitions.  These are used to control the link-
editing of objects into load modules.

• Compilation Control Architecture Definitions.  These are used to control the 
compilation of source objects into object code or even load modules.  They are 
typically used when you want to compile a module using slightly different 
options and parameters than those defined in a language definition.

• Generic Architecture Definitions. These are used to process members that do not 
generate object modules.

Only a Linkage Editor Control definition can be sourced from an existing load 
module, while generic, compilation control, and linkage editor control definitions can 
be sourced from JCL. 

Note:  While the process of  creating an architecture definition from a load module or 
JCL is designed to produce results that are close to final, you may need to do some 
tailoring to achieve the final result.

The Architecture Definition Wizard allows you to create architecture definitions 
(ARCHDEFs) by hand or by importing them from an existing load module or existing 
JCL.  Before generating architecture definitions for a new project, you should ensure 
that the source members have been migrated into the project prior to generating the 
ARCHDEFs. 

From the workstation

You can use the Architecture Wizard to create a new definition or modify an existing 
definition.  Highlight the project you want to work with. Then, from the SCLM pull-
down at the top of your workspace, click Architecture Definition Wizard.  SCLM 
Suite Administrator Workbench displays the Architecture Definition dialog

Modifying an existing architecture definition

To modify an existing architecture definition:

1. On the first page of the wizard, specify the architecture definition group and 
Type. 

2. Click the List Architecture Definitions radio button.   From the display of 
existing ARCHDEFs,  select the one you want to edit. 

3. The wizard displays a list of  existing ARCHDEF from which you can select one to 
edit.

4. In the wizard’s Editor window, edit the ARCHDEF you selected, and press Finish 
to save your changes. 
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Creating a new architecture definition

To create a new architecture definition:

1. On the first page of the wizard, specify the architecture definition group and 
Type. 

2. Click the  Create New Architecture Definition radio button.

3. On the next wizard panel, specify a name of up to 8 characters in length for your 
new definition.  Select the ARCHDEF type from the drop-down list box:

• High Level

If you selected a High Level ARCHDEF, you can create one only from scratch. 
The Linkage Editor Language ID and SCLM Load Library text boxes display 
default values. You can change these by overtyping them. Clicking Next 
displays the Architecture Definition Editor, where you can enter the text of 
the ARCHDEF you are creating. When you are satisfied with your work, click 
Finish to save your new ARCHDEF.

• Link Edit Control

A Link Edit Control ARCHDEF can be created from existing load module(s), 
existing JCL, or from scratch. If you choose to enter one from scratch, clicking 
Next displays the Architecture Definition Editor, where you can enter the text 
of the ARCHDEF you are creating. When you are satisfied with your work, 
click Finish to save your new ARCHDEF. 

If you will create your new ARCHDEF from Existing load module(s) or 
existing JCL (by clicking the appropriate radio button):

a. Specify the data set name where the model load module or JCL can be 
found. You can browse for the data set by clicking the Browse button

b. Once you have selected the data set, a list of members appears in the 
drop-down list box. Select the member that contains the model you want 
to use. Default values are supplied for the Language ID and Load Library 
Type. Overtype these to change them. 

c. Clicking Next displays the text of the member you have selected in the 
ARCHDEF editor. Modify the model text.

d. When you are satisfied with your work, click Finish to save the new 
Architecture Definition.

 There are some considerations that should be taken into account when 
creating an architecture definition from JCL.  For information, see 
“Considerations when creating a language definition from JCL” on page 45.

• Compilation Control or Generic

A Compilation Control or Generic ARCHDEF can be created either from 
existing JCL or from scratch. If you choose to enter one from scratch, clicking 
Next displays the Architecture Definition Editor, where you can enter the text 
of the ARCHDEF you are creating. When you are satisfied with your work, 
click Finish to save your new ARCHDEF. 

If you will create your new ARCHDEF from existing JCL (by clicking the 
appropriate radio button):

a. Specify the data set name where the model load module or JCL can be 
found. You can browse for the data set by clicking the Browse button. 

b. Once you have selected the data set, a list of members appears in the 
drop-down list box. Select the member that contains the model you want 
to use. Default values are supplied for the Language ID and Load Library 
Type. Overtype these to change them. 
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c. Clicking Next displays the text of the member you have selected in the 
ARCHDEF editor. Modify the model text. 

d.  When you are satisfied with your work, click Finish to save the new 
Architecture Definition.

From an ISPF session

You can create a new architecture definition or modify an existing definition using the 
Architecture Definition Wizard.   To access the wizard:

1. From the SCLM Suite Administrator Workbench Project Administration Main 
Menu, specify option 3 — List on the Command line.

2. SCLM Suite Administrator Workbench displays the Project List. 

3. Place an A on the line next to the project or projects for which you wish to create 
an architecture definition and press Enter. 

Creating an architecture definition

To create an architecture definition using the wizard:

1. In the project list, place an A on the line next to the project or projects for which 
you wish to create an architecture definition and press Enter. 

2. On the Architecture Definition Wizard panel, specify 2 on the line provided. 
Option 2 permits  you to create a new architecture definition for the SCLM group 
and Type you specify in the Architecture Definition Group and Architecture 
Definition Type fields. These fields identify the group and Type to which this 
architecture definition will belong, or the group and Type for which this 
definition will be  listed

• To view a list of groups from which you can select a group,  G on the Option 
line.

• To view a list of Types from which you can select a Type, specify T on the 
Option line.

3. SCLM Suite Administrator Workbench displays the Architecture Definition 
Specification panel.  On this panel, specify:

• A name for the new architecture definition

• The kind of architecture definition you are creating: high-level, linkage editor 
control, compilation control, or generic.

• The linkage editor language ID. The default, LE370, is filled in for you.  You 
can change this value by overtyping it.

• The SCLM load library Type.  The default, LOAD, is filled in for you.  You can 
change this value by overtyping it.

4. When you press Enter,  SCLM Suite Administrator Workbench displays a panel 
on which you can specify how you will create the new ARCHDEF. 

• If you select Option 1, Create from Existing Load Module,  SCLM Suite 
Administrator Workbench displays a panel on which you can enter or browse 
for the name of the data set and member that contains the model load 
module(s).  You can browse  for the data set name by specifying at least one 
partial qualifier using asterisks as wild cards.   

 Once you have specified a valid data set name, a list of members is displayed.  
Select a member from the list or enter the member name directly. You can 
change the contents of the Member field by overtyping it.
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 You can add source Types available to be used for your architecture 
definition to this panel by specifying A on the Option line. 

• If you select Option  2, Create from Existing JCL,  SCLM Suite Administrator 
Workbench displays a panel on which you can enter or browse for the name 
of the data set and member that contains the model JCL.  You can browse  for 
the data set name by specifying at least one partial qualifier using asterisks as 
wild cards.   

 Once you have specified a valid data set name, a list of members is displayed.  
Select a member from the list or enter the member name directly. You can 
change the contents of the Member field by overtyping it.

• If you select Option 3, Create from Scratch, SCLM Suite Administrator 
Workbench displays an ISPF Editor page on which you can enter your new 
ARCHDEF. 

Working with the Architecture Definition Listing

If you select option 1, SCLM Suite Administrator Workbench displays the 
Architecture Definition List panel.  Use this panel to view, edit, or delete architecture 
definitions from your project.  You can view an architecture definition  by entering V 
on the line preceding its name.  You can edit an architecture definition by entering E.  
Press Enter to process your choices. 

In either case, the Architecture Definition Wizard  displays an ISPF edit panel with the 
architecture definition you selected filled in. Note that you can update this 
information only if you accessed this panel using an Edit (E) request.

You can also use the Architecture Definition Listing panel to delete an architecture 
definition or multiple definitions from your project  by entering D on the line 
preceding those definitions to be deleted.  Once you have confirmed your choice to 
delete a definition or definitions,  SCLM Suite Administrator Workbench removes 
these from the list of architecture definitions associated with your project.

Entering an architecture definition from scratch

If you select option 2, SCLM Suite Administrator Workbench displays an ISPF editor 
panel.  Type in your new architecture definition.  Press PF3 to save your work and exit 
architecture definition.

Creating an architecture definition from load modules

If you select option 3 from the Architecture Definition Specification Menu, SCLM 
Suite Administrator Workbench displays the Create Architecture Definition from 
Load Modules panel.  On this panel, you can enter the name of the data set and 
member that contain the model architecture definition.  To browse for a data set, press 
PFnn in the Enter Source Data Set  field.  SCLM Suite Administrator Workbench 
displays a data set list from which you can select the data set you want to work with.  

Enter the name of a member from this data set in the Enter source member field.  If 
you want to browse for a member name, press PFnn. When the list of members is 
displayed, select the those you want by typing an S or a slash (/) on the line in front of 
the member.

On this panel, you are also asked to enter:

• The Linkage Editor Language ID.  The default, LE370, is filled in for you.  To 
change  the information, simply overtype it.
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• The SCLM Load Library Type.  The default, LOAD, is filled in for you.  To change 
the information, simply overtype it.

The load modules you selected are displayed in the Architecture  Definition Editor.  
Make any necessary changes and save your work

Creating an architecture definition from JCL

If you select option 4 from the Architecture Definition Specification Menu,  SCLM 
Suite Administrator Workbench displays the Create Architecture Definition from JCL  
panel. To browse for a JCL data set, press PFnn  in the Enter Source Data Set  field.  
SCLM Suite Administrator Workbench displays a data set list from which you can 
select the data set you want to work with. 

Enter the name of a JCL member from this data set in the Enter source member field.  
If you want to browse for a member name, press PFnn. 

On this panel, you are also asked to enter:

• The Linkage Editor Language ID.  The default, LE370, is filled in for you.  To 
change  the information, simply overtype it.

• The SCLM Load Library Type.  The default, LOAD, is filled in for you.  To change 
the information, simply overtype it.

 The JCL member or members you selected are displayed in the Architecture  
Definition Editor.  Make any necessary changes and save your work. There are some 
considerations that should be taken into account when creating an architecture 
definition from JCL.  For information, see “Considerations when creating a language 
definition from JCL” on page 45.

Considerations when creating an architecture definition from JCL

When creating architecture definitions from JCL you should select a job that meets the 
following criteria, or copy and modify the selected job to meet the criteria.  Since the 
architecture definition identified the constituents of a built object, only the first step 
that executes a program that matches the desired architecture definition kind will be 
used in generating the architecture definition.  If you have a job that links a number of 
load modules, for example, you will need to split the job into multiple jobs for 
translation into architecture definitions.  The processing will vary based on the kind of 
architecture definition being generated.  The criteria are:

• A JOB statement should span three lines; for example:

//JOBNAME  JOB 01,

//  'Text',

//  CLASS=A,

//  MSGCLASS=8

• The job should only compile or link a single program, otherwise the generated 
architecture definition will require excessive tailoring.

• Jobs may execute PROCs -- either inline or from a PROC library.

 

The job is modified as follows and copied into <PROJECT>.PROJDEFS.JCL:

• Change the job name to user id + 'A'.

• Add TYPRUN=SCAN to the JOB statement.
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The job is submitted and the output retrieved to parse the JCL into an architecture 
definition using the actual data set names and other parameters that were substituted 
during the TYPRUN=SCAN operation.

The rules depend on the architecture definition being generated.  For a Compilation 
Control architecture definition, the following statements are generated:

• INCL

• OBJ

• LIST

• PARM

For a Linkage Editor Control architecture definition, the following statements are 
generated:

• INCL

• LOAD

• LMAP

• PARM

• CMD

When a Linkage Editor Control architecture definition is created, the data sets 
comprising the SYSLIN DD are read and lines beginning with a space treated as 
Binder or Linkage Editor control statements.  If these are INCLUDE statements, the 
SCLM hierarchy is searched to determine whether an INCL or CMD INCLUDE 
statement should be generated.  If they are other Linkage Editor Control Statements, 
with the exception of IMPORT statements, they are included as CMD <command>.

Following are two sample jobs and the pre-tailoring architecture definition that was 
generated from each:

Sample job 1:

//AUZCOBCM JOB 01,  
 //           'CHRIS BAILEY', 
 //           CLASS=A,    
 //           MSGCLASS=X,      
 //           NOTIFY=&SYSUID,  
 //           USER=,GROUP=,PASSWORD=       
 //*   
//*   
//COMPILE EXEC PGM=IGYCRCTL, 
//             PARM=(XREF,LIB,APOST,NODYNAM,LIST,NONUMBER,NOSEQ)    
//SYSLIN   DD DSN=ADMIN02.DEV1.OBJ(SPIKE001),DISP=SHR 
//SYSLIB   DD DSN=ADMIN02.DEV1.COPYBOOK,DISP=SHR     
//         DD DSN=ADMIN02.STG1.COPYBOOK,DISP=SHR    
//         DD DSN=ADMIN02.TEST.COPYBOOK,DISP=SHR     
//         DD DSN=ADMIN02.PROD.COPYBOOK,DISP=SHR  
//SYSIN    DD DSN=ADMIN02.DEV1.COBOL(SPIKE001),DISP=SHR 
//SYSUT1   DD UNIT=SYSDA,SPACE=(CYL,(2,2))     
//SYSUT2   DD UNIT=SYSDA,SPACE=(CYL,(2,2)) 
//SYSUT3   DD UNIT=SYSDA,SPACE=(CYL,(2,2))   
//SYSUT4   DD UNIT=SYSDA,SPACE=(CYL,(2,2))       
//SYSUT5   DD UNIT=SYSDA,SPACE=(CYL,(2,2))  
//SYSUT6   DD UNIT=SYSDA,SPACE=(CYL,(2,2))  
//SYSUT7   DD UNIT=SYSDA,SPACE=(CYL,(2,2))  
//SYSPUNCH DD DUMMY      
//SYSPRINT DD SYSOUT=* 
//SYSTERM  DD DUMMY  
//*             
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Generated architecture definition:

* GENERATED BY JCL2ARCHDEF
*
OBJ SPIKE001 OBJ     
LIST SPIKE001 LIST 
CMD  INCLUDE SYSLIB(SPIKE001)     
PARM XREF,      
PARM LIB,  
PARM APOST,  
PARM NODYNAM,                         
PARM LIST, 
PARM NONUMBER,   
PARM NOSEQ                             

Sample job 2:

//LINK    JOB 01,  
 //           'CHRIS BAILEY', 
 //           CLASS=A,    
 //           MSGCLASS=X,      
 //           NOTIFY=&SYSUID,  
 //           USER=,GROUP=,PASSWORD=       
 //*   
//* COPYRIGHT (C) 2002, ROCKET SOFTWARE, INC. ALL RIGHTS RESERVED. 
//*
//*   //MDTECRB  EXEC PGM=IEWL   
//SYSLIB   DD  DSN=CEE.SCEESPC,   
//           DISP=SHR     
//         DD  DSN=CEE.SCEELKED,      
//           DISP=SHR      
//MODLIB   DD  DSN=MDTECRB.PROJDEFS.OBJ,      
//           DISP=SHR       
//SYSLMOD  DD  DSN=MDTECRB.PROJDEFS.LOAD(MDTECRB),          
//           DISP=SHR  
//SYSUT1   DD  DSN=$$SYSUT1,  
//           UNIT=VIO,    
//           SPACE=(1024,(50,25)),        
//           DISP=(NEW,DELETE,DELETE)       
//SYSPRINT DD  SYSOUT=*       
//SYSLIN   DD  *        
 INCLUDE MODLIB(MDTECRB)     
 NAME MDTECRB(R)         
//* 

Generated architecture definition:

 
* GENERATED BY JCL2ARCHDEF    
*                             
LKED LE370                    
LOAD MDTECRB LOADLIB          
LMAP MDTECRB LKEDLIST         
INCLD MDTECRB ASM       
 CMD  NAME MDTECRB(R)              
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Part 3. Administering EAC

This part describes the facilities that SCLM Suite Administrator Workbench provides 
to assist you in administering IBM Enhanced Access Control for SCLM and provides  
instructions for performing the administration tasks the product supports.  For 
information about administering Software Configuration and Library Manager 
(SCLM) Suite Administrator Workbench, see Part 2, “Administering SCLM,” on page 
5.

If SCLM Suite Administrator Workbench has not yet been installed and configured for 
your site, refer to the IBM SCLM Suite Administrator Workbench: Installation and 
Customization Guide for information on installing the host and workstation 
components of the product and performing the required customization.

Note:  Before you can begin to use SCLM Suite Administrator Workbench,   
customization of the host component as described in the IBM SCLM Suite 
Administrator Workbench: Installation and Customization Guide must be completed.  
This work normally is performed by an enterprise’s systems programmer.  To use the 
client workstation component, each workstation component must be customized as 
described in that Guide.

   

 

Important: In order to perform the activities involved in administering Enhanced 
Access Control for SCLM resources using SCLM Suite Administrator Workbench, you 
must have RACF SPECIAL authority. 
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Chapter 12. Getting Started with Enhanced Access Control for 
SCLM Administration

In order to perform the activities involved in administering Enhanced Access Control 
for SCLM resources using SCLM Suite Administrator Workbench, you must have 
RACF SPECIAL authority.

When you open an SCLM Suite Administrator Workbench session, you will see 
Enhanced Access Control for SCLM  in the Remote Systems Navigator pane at the left 
side of your workspace.  When you click to open Enhanced Access Control for SCLM, 
it expands to display All EAC Resources.  The Enhanced Access Control for SCLM  
resources with which you can work are:

• RACF Data Set Profiles

• Enhanced Access Control for SCLM Profiles

• Enhanced Access Control for SCLM Applications

• Enhanced Access Control for SCLM Violations

 Before you can use the Enhanced Access Control for SCLM functions of SCLM Suite 
Administrator Workbench, you must define at least one Rule File outside of SCLM 
Suite Administrator Workbench.  Each EAC Manager instance may have a default 
Rule File, which you specify using Preferences as described in the next section, 
“Defining Rule Files”.  Specifying a Rule File you have defined to be the default 
causes the selected Rule File to be used for all subsequent actions that occur while you 
are in this view.

Defining Rule Files

Follow these steps to define your Enhanced Access Control for SCLM Rule File 
defaults to SCLM Suite Administrator Workbench.

• In the SCLM Suite Administrator Workbench perspective, from the Window 
pulldown, select Preferences > EAC Manager.  SCLM Suite Administrator 
Workbench displays a panel on which you can associate a Rule File with a specific 
instance of Enhanced Access Control for SCLM.  The table that is displayed each 
time you go to the Preferences displays already-defined systems together with 
their associated default Rule Files.

• To remove an existing System/Rule File association from the table, click its row in 
the table.  Then click the Remove button.

• To add a System/Rule File association:

1. Click the Add  button to add a blank row to the table.

2. Click the cell in the System column to select the system you want to work 
with from the drop-down list that is displayed.

3. Enter the name of the Rule File you want to associate with this system in the 
Rules DSN column.

4. Optionally, add a description of the association in the Description column.

5. Press Enter to save your work.

• Click OK to complete your EAC Preferences definition or Cancel to exit without 
committing your work.
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Filtering objects displayed in the Enhanced Access Control for SCLM 
Navigator Tree

You can filter the objects that  SCLM Suite Administrator Workbench presents to you 
in the Remote Systems Navigator tree.  For information on how to do so, see “Filtering 
objects in the Remote Systems Navigator tree” on page 8.
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Chapter 13. Maintaining RACF Data Set Profiles

Before you can create a new RACF Data Set Profile or maintain an existing Profile, you 
must have created any necessary groups and users outside of the SCLM Suite 
Administrator Workbench.  In order to perform the activities involved in 
administering Enhanced Access Control for SCLM resources using SCLM Suite 
Administrator Workbench, you must have RACF SPECIAL authority.

Start SCLM Suite Administrator Workbench and expand the EAC Manager > All 
EAC Resources.  Expand RACF Data Set Profiles to display a list of existing RACF 
data set profiles in the Navigator tree. From the Navigator tree, you can:

• Create a profile.  Right-click RACF Data Set Profiles, then select New from the 
pop-up menu, or right-click EAC Manager, then select RACF Data Set Profiles 
from the pop-up menu.  

• Edit a Profile. Right-click a profile name in the Navigator tree, then select Edit 
from the pop-up menu. This  option causes the selected profile to be displayed 
with any modifiable fields displayed next to an action indicator.  You can modify 
any such entry, and, if appropriate, add or delete the entry and any subordinate 
entries. Once you have made your changes, pressing Enter and confirming the 
changes causes the RACF Database  to be updated with the modified profile.  The 
List of RACF Data Set Profiles is redisplayed, showing that the profile in question 
has been modified.  Any modified values are displayed as part of the list. If you 
choose to cancel the modification, the list is redisplayed exactly as it was initially. 

• View an existing profile. Right-click a profile name in the Navigator tree, then 
select View from the pop-up menu. 

• Delete the profile.  Right-click a profile name in the Navigator tree, then select 
Delete from the pop-up menu.

Creating a RACF data set profile

To create a new RACF data set profile: 

1. Right-click RACF Data Set Profiles, then select New > RACF Data Set Profile 
from the pop-up menu.  SCLM Suite Administrator Workbench displays the first 
page of the RACF Data Set Profile Wizard.  On this page, you can specify:

• A RACF data set profile name

• Whether or not a generic data set refresh will be performed to update any 
SETROPTS changes resulting from information provided in this wizard; that 
is, whether the command SETROPTS GENERIC(DATASET) REFRESH will be 
performed after the update. Note that, if you select this option, the refresh 
that is performed will also include any changes you have made outside of 
SCLM Suite Administrator Workbench since the last refresh or the last system 
IPL.

• Whether or not users will be permitted to access the data set RACF-protected 
by this profile even though their access authority is insufficient to do so.  If 
you choose to permit this access, the user that is attempting the access 
receives a warning message and the user ID specified in the Notify text box 
on this panel is notified of the access.

• Whether or not z/OS data management physically erases the DASD data set 
extents if the data set protected by this RACF data set profile is deleted. 
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• The universal access authority for the data set.  All RACF-protected data sets 
have a universal access authority specified for them. This is the level of access 
granted to all users or groups, except for those users or groups specifically 
named in the data set’s access list as having a different level of access.  For 
example, if a data set’s universal access were READ, and a user in the access 
list had UPDATE authority, that user would continue to have UPDATE 
authority for the data set. Universal access authority may be:

— NONE -- permits no data set access.

— READ --  permits read access to the data set

— UPDATE -- permits both read and write access to the data set

— CONTROL -- permits read and write access to the data set, including 
VSAM improved control interval processing

— ALTER --  permits read, write, delete, rename, move, and scratch access 
to the data set

• Your access authority to the data set, which may be:

— NONE -- permits no data set access.

— READ --  permits read access to the data set

— UPDATE -- permits both read and write access to the data set

— CONTROL -- permits read and write access to the data set, including 
VSAM improved control interval processing

— ALTER--  permits read, write, delete, rename, move, and scratch access to 
the data set

If you are not the owner of the data set, you must request that the ID specified 
in the Owner field issue a PERMIT command to give you access to the data 
set.

• The user ID or group that is the owner of the data set profile.  If you created 
the data set and RACF-protected it, but did not specify an owner, you are 
considered to be the owner of the data set profile, and can modify the profile.

• The user ID or group that is to be notified by RACF if access to the data set is 
denied

• The user ID or group that is the owner of the RACF-protected data set to 
which this data set profile applies

• The name of the group under which the profile was created

• The profile type, which may be Model, Tape,  or Generic

• The unit type on which this data set resides

• For VSAM data sets, the volume on which the catalog resides

• The security retention period

• The security level, which is a name that is associated with the numeric value 
that is found in the LEVEL field for the data set.  Your installation can define 
its own security levels.  The security level that you enter in the text box on this 
Wizard page specifies the minimum level that is required to access a data set 
protected by this profile.

• The security label, which is a name that  represents an association between a 
particular security level and a set of zero or more security categories. Your 
installation can define its own security labels.  The security label that you 
enter in the text box on this Wizard page specifies the minimum  that is 
required to access a data set protected by this profile.

2. When you have completed the information above, press Next to display the next 
page of the RACF Data Set Profile Wizard.  On this page, specify the following:
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• A name that represents the security category needed to access the data sets 
protected by this profile.  Your installation can define its own security 
categories.  To add a category to the profile, specify its name in the text box 
and click the Add button.  To remove a category from the profile, click its 
name in the display box and then the Remove button.

• The type of auditing that will occur for data set access requested to the data 
sets protected by this profile. You can select one of the following auditing 
types:

— ALL -- indicating that all types of access attempts are to be recorded

— FAILURES -- indicating that any failed access attempts are to be recorded

— SUCCESSES -- indicating that any successful access attempts are to be 
recorded

— NONE -- indicating that no recording is to occur

• The type of access requests that are to be recorded for this auditing type.  You 
may select READ, UPDATE, CONTROL, ALTER, or NONE.

Once you have selected an auditing type and associated access type from the 
pulldown boxes, clicking Add adds these to your profile.  To remove an 
auditing type/access type combination from the profile, click its name in the 
display box, then the Remove button.

3. When you have completed the information above, press Next to display the last 
page of the RACF Data Set Profile Wizard. This page permits you to construct an 
access list.  The access list permits you to allow or deny specify user IDs or groups 
access to the protected data set that differs from the universal access you have 
specified for the data set.  On this page, specify the following

• The type of access to be granted to the user ID or group that you will specify 
in the text entry boxes that follow.  From this pulldown box, you 

• may select READ, UPDATE, CONTROL, ALTER, or NONE.

• The user ID or group name that is to be added to the access list for this access 
type.  To add a new user ID or group name, specify its name in the User text 
box and click Add.  To remove a user ID or group name from the access list, 
select its name from the display box and click Remove.

• The use of a conditional access list.  A conditional access list is an access list in 
the data set profile that specifies an additional condition that must be satisfied 
in order to grant access to the user ID or group specified in the User field.  If 
you place a check in this box, you must then specify a key and value in the 
text entry boxes that follow.

• A key and associated value to serve as additional conditions for access for the 
user specified in the User text entry box. To enter a new key and associated 
value, select the key from the Key pulldown box, enter information as follows 
in the Value text entry box, and click the Add button.  To remove a Key/Value 
combination from the display box, click its name, then the Remove button.  
The keys and associated values are as follows:

— If you select the PROGRAM key, you must specify the name of the 
program the user must be running in order to access this data set in the 
Value text entry box.

— If you select the LU NAME key, you must specify the partner logical unit 
name or APPC port through which the user must enter the system in the 
Value text entry box.

— If you select the CONSOLE key, you must specify the system console ID 
from which the request must be sent in the Value text entry box.
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— If you select the TERMINAL key, you must specify the terminal ID of the 
terminal through which the user must enter the system in the Value text 
entry box.

When you have completed the fields on this panel, click Finish to complete the 
definition of your RACF data set profile.

Editing a RACF data set profile

To edit an existing RACF data set profile, right-click a profile name in the Navigator 
tree, then select Edit from the pop-up menu. This  option causes SCLM Suite 
Administrator Workbench to display the first panel of the RACF Data Set Profile 
Wizard with information for the selected profile filled in the text fields. You can 
modify any modifiable fields as you proceed through the Wizard. Once you have 
made your changes, pressing Finish causes the RACF Database  to be updated with 
the modified profile.  

Viewing a RACF data set profile

To view a RACF data set profile, right-click a profile name in the Navigator tree, then 
select View from the pop-up menu.  This option causes SCLM Suite Administrator 
Workbench to display the RACF Data Set Profile Wizard. Information for the selected 
profile is displayed in the Wizard exactly as it would if it were going to be modified.  
However, the fields are not modifiable.   

Deleting a RACF data set profile

To delete a  RACF data set profile,  right-click a profile name in the Navigator tree, 
then select Delete from the pop-up menu.  This  option causes the selected RACF data 
set profile to be deleted following confirmation from you.
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Chapter 14. Maintaining Enhanced Access Control for SCLM 
Profiles

In order to perform the activities involved in administering Enhanced Access Control 
for SCLM resources using SCLM Suite Administrator Workbench, you must have 
RACF SPECIAL authority. 

Start SCLM Suite Administrator Workbench and expand the EAC Manager > All 
EAC Resources.  Expand Profiles to display a list of existing Enhanced Access 
Control for SCLM profiles in the Navigator tree. From the Navigator tree, you can:

• Create a profile.  Right-click Profiles, then select New >Profile from the pop-up 
menu, or right-click EAC Manager and select New > EAC Profile from the pop-
up menu.  

• Edit a Profile. Right-click a profile name in the Navigator tree, then select Edit 
from the pop-up menu. This  option causes the selected profile to be displayed. 

• View an existing profile. Right-click a profile name in the Navigator tree, then 
select View from the pop-up menu. 

• Delete the profile.  Right-click a profile name in the Navigator tree, then select 
Delete from the pop-up menu.

Creating a new Enhanced Access Control for SCLM profile

To create a new Enhanced Access Control for SCLM profile: 

1. Right-click Profiles, then select New > Profile from the pop-up menu.  SCLM 
Suite Administrator Workbench displays the Enhanced Access Control for SCLM 
Profile dialog. 

2. On this dialog, specify the following:

• The fully-qualified name of an Enhanced Access Control for SCLM profile 
data set.  You can use wild cards to specify the data set name(s)

• A text description of this profile.

3. In the Application/Function section of this dialog, SCLM Suite Administrator 
Workbench displays a list of Application/Function pairs that have been defined 
for this profile.  If you would like to add an application/function pair to this set, 
click the Add button.   This displays the Application Selection dialog from which 
you can select one or more application/function pairs to be added to the 
Enhanced Access Control for SCLM profile you are working with.

4. To edit the  user ID/access combinations associated with this profile, click Edit.   
This displays the Application Selection dialog with the information for the 
application/function combination you want to edit filled in on that panel.

5. If you would like to remove an application/function pair from association with 
this profile, click its name in the Application/Function list box. Then click 
Remove.

Using the Application Selection Dialog

If you have chosen to add or edit an application/function combination associated 
with a profile, pressing the appropriate button displays the Application Selection 
Dialog.
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The User Access section of this dialog displays the user ID and access combinations 
associated with this application/function pair you have selected. you can add or 
remove users from this profile, as well as specify user access.  

• To add a user, enter the user’s name of up to 8 characters in the text box, select the 
user’s access from the drop-down list box, and click Add User.

• To remove a user, select the user’s name from the User list box and press Remove 
User.

• To alter a user’s access, you must first remove the user with the access type you 
want to change, then add the user back with the changed access type..  

The types of user access available from the drop-down box follow:

• Alter permits read, write, delete, rename, move, and scratch access to the data set 
.

• Control permits read and write access to the data set, including VSAM improved 
control interval processing 

• None permits no data set access. 

• Read permits read access to the data set 

• Update permits both read and write access to the data set 

When you have completed your tasks on this panel, click OK to save your work. 

Editing an Enhanced Access Control for SCLM profile

To edit an existing Enhanced Access Control for SCLM profile, expand EAC Manager 
> All EAC Resources > Profiles.  Right-click its name of the profile you want to edit 
in the Navigator tree. If you selected Edit EAC Profile,  SCLM Suite Administrator 
Workbench displays the EAC Profile Dialog with the previously-defined values for 
the profile you selected filled in.  Follow the steps shown in “Creating a RACF data set 
profile” on page 71 to make the required changes to this profile.  Click OK to save  
your work.

Viewing an Enhanced Access Control for SCLM profile

To view an Enhanced Access Control for SCLM profile, right-click a profile name in 
the Navigator tree, then select View from the pop-up menu.  This option causes 
SCLM Suite Administrator Workbench to display the Enhanced Access Control for 
SCLM  Profile dialog. Information for the selected profile is displayed in this dialog 
exactly as it would if it were going to be modified.  However, the fields are not 
modifiable.   

Deleting an Enhanced Access Control for SCLM profile

To delete an Enhanced Access Control for SCLM profile,  right-click a profile name in 
the Navigator tree, then select Delete from the pop-up menu. This  option causes the 
selected profile to be deleted following confirmation from you.
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Chapter 15. Maintaining Enhanced Access Control for SCLM 
Applications

In order to perform the activities involved in administering Enhanced Access Control 
for SCLM resources using SCLM Suite Administrator Workbench, you must have 
RACF SPECIAL authority. 

Start SCLM Suite Administrator Workbench and expand the EAC Manager > All 
EAC Resources.  Expand Applications to display a list of existing Enhanced Access 
Control for SCLM profiles in the Navigator tree. From the Navigator tree, you can:

• Create an application.  Right-click Applications, then select New > Application 
from the pop-up menu, or right-click EAC Manager and select New > EAC 
Application from the pop-up menu..  

• Edit an Application. Right-click an application name in the Navigator tree, then 
select Edit from the pop-up menu. 

• View an existing application. Right-click an application name in the Navigator 
tree, then select View from the pop-up menu. 

• Delete the application.  Right-click an application in the Navigator tree, then 
select Delete from the pop-up menu.

Creating a new application

To create a new application: 

1. Right-click Applications, then select New > Application from the pop-up menu.  
SCLM Suite Administrator Workbench displays the EAC Application dialog. 

2. On this dialog, specify the following:

• The application’s name

• The name of a function to be associated with this application

• Optionally, a text description of this application/function pair.

3. In the High/Low Program Pairs section of this dialog:

• To add a high/low program pair,  specify the names of the high and low 
programs in the text boxes provided. Press Add Programs when you are 
done.

• To remove an existing high/low program pair, click its name in the list box, 
then click Remove Programs.

 

4. When you have completed your tasks on this panel, click OK to save your work. 

Editing an application

To edit an existing Enhanced Access Control for SCLM application, expand EAC 
Manager > All EAC Resources > Applications.  Right-click its name of the 
application you want to edit in the Navigator tree.  SCLM Suite Administrator 
Workbench displays the EAC Application Dialog with the previously-defined values 
for the application you selected filled in.  Follow the steps shown in  to make the 
required changes to this application.  Click OK to save  your work.
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Viewing an Enhanced Access Control for SCLM application

To view an Enhanced Access Control for SCLM application, right-click its name in the 
Navigator tree, then select View from the pop-up menu.  This option causes SCLM 
Suite Administrator Workbench to display the EAC  Application dialog. Information 
for the selected application is displayed in this dialog exactly as it would if it were 
going to be modified.  However, the fields are not modifiable.   

Deleting an Enhanced Access Control for SCLM application

To delete an Enhanced Access Control for SCLM application,  right-click its name in 
the Navigator tree, then select Delete from the pop-up menu. This  option causes the 
selected application to be deleted following confirmation from you.
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Chapter 16. Reviewing Enhanced Access Control for SCLM 
Violations

SCLM Suite Administrator Workbench assists you in maintaining the security of your 
installation by building and displaying a list of Enhanced Access Control for SCLM 
violations for your review.  In order to perform the activities involved in 
administering Enhanced Access Control for SCLM resources using SCLM Suite 
Administrator Workbench, you must have RACF SPECIAL authority. 

To review a list of Enhanced Access Control for SCLM violations and take 
appropriate action:

1. Start the Violations Wizard by double-clicking Violations in the Remote Systems 
Navigator, or right-click Violations in the Navigator, then select View from the 
pop-up menu.

2. From the list of violations displayed by SCLM Suite Administrator Workbench, 
select the one you want to work with and press Next.

3. The Validation Wizard displays page 1 of the Validation Detail dialog, showing 
information about the violation you suggested. After reviewing the information, 
press Next. 

4.  The Validation Wizard displays page 2 of the Validation Detail dialog. When you 
have reviewed this page, press Finish.

The Validation Detail panels provide you with the following information:

• The profile definition (fully qualified data set name) that Enhanced Access 
Control for SCLM selected to validate a user’s ability to access a given resource.  
This profile matches either the name of the data set against which the user 
requested access, or the generic profile definition that matches the one used by 
RACF to validate access requests.

• The application definition that Enhanced Access Control for SCLM used to 
validate a user’s ability to access a given resource.

• The function that Enhanced Access Control for SCLM used to validate a user’s 
ability to access a given resource.

• The user ID or RACF group list entry that Enhanced Access Control for SCLM 
used to validate a user’s ability to access a given resource.  This field can contain 
one of the following values:

— The RACF user ID of the user associated with the access request

— GRPLIST, indicating that one or more of the user’s RACF current connect 
groups was matched in the profile access rules

— *, indicating that the profile access rule * (indicating all users) was matched

— blank, indicating that a match of the user ID or RACF current connect group 
was not found in the profile access rules, or that validation failed before 
matching was performed

• The reason for the violation

• The name of the entity for which access was requested and validation was failed.  
This name may be a data set name or a profile definition.

• The date and time the access request was made

• The user ID that requested access
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• The name of the RACF current connect group associated with the access request

• The privilege that was required by RACF in order to allow the access request

• The access privilege returned to RACF by Enhanced Access Control for SCLM.  
Typically, the Access Granted field will be for a lesser degree of access than the 
Access Required field, thus creating the violation.

• The execution program environment at the time that the access request was made.  
This field shows the programs in control when the data set access was attempted. 
This field contains a top-down list of programs that were executing, as well as 
indicators showing the high and low programs.   
 80 IBM Software Configuration and Library Manager Suite Administrator Workbench: User’s Guide  



Part 4. Appendixes
© Copyright IBM Corp.  2003, 2004 81  



 

82 IBM Software Configuration and Library Manager Suite Administrator Workbench: User’s Guide  



Appendix A.    Messages and Codes

This appendix documents the messages and codes that may be displayed during the 
operation of SCLM Suite Administrator Workbench, together with actions that may be 
taken by the system, as well as actions that you may need to take.

All messages generated by SCLM Suite Administrator Workbench have a severity 
code printed as the last character of the message ID. The severity codes are described 
in the following table:

   

 
Error Writing File.  There may not be enough temporary 
disk space.  Try using  -is:tempdir to use a temporary 
directory on a partition with more disk space. 

Severity:  Warning

Explanation:  The SCLM Suite Administrator Workbench 
installation program needs a temporary area on disk with 
a sufficient amount of space.  

User Response:  Specify the installation directory as 
follows:: 

mmmmmmmm -is:tempdir "directory-path"

where:

• mmmmmmmm is the name of an installer such as 
AUZLNGTK.bin or AUZWIN32.exe, and

• directory-path represents the path to the temporary 
directory, for example, /tmp/AUZ. 

error.number.tar

Explanation:  During file build or rebuild, if an error 
occurs, a file called error.number.tar is created.  

User Response:  Save the file and notify  support.

AUZ002E  Invalid Selection -- Please enter a 
Valid Option or X to Exit

Explanation:  You have entered an option that is invalid 
on this panel

User Response:  Enter an option that is valid for this 
panel.

AUZ003E  Invalid Value -- Please enter a "b" if 
you would like to run jobs in batch 
mode or "F" to run jobs in foreground 
mode.

Explanation:  You have entered an option that is invalid 
on this panel

User Response:  Enter either B or F..

AUZ004E  Invalid Value -- You must enter a "Y" 
or "N".

Explanation:  You have entered an option that is invalid 
on this panel

User Response:  Enter Y or N.

AUZ006E  Invalid Selection 

Explanation:  You have entered an option that is invalid 
on this panel

User Response:  Enter an option that is valid for this 
panel.

AUZ007E  Invalid Value

Explanation:  You have entered a value that is invalid on 
this panel

Table 2. Error message severity codes

 Severity Code Description

I Information only. No user action required.

W Warning message. Results may not be as expected. 

E Error message. Some may be user-correctable; read the User 
Response to determine the course of action.

S Severe error.  Some may be user-correctable; read the User 
Response to determine the course of action.
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User Response:  Enter a value that is valid for this panel.

AUZ008E  Project XML member not found or 
corrupted.

Explanation:  You have requested to work on a project for 
which the XML member is either unknown or corrupt.

User Response:  Review your project specifications and 
the log file to determine what the problem may be.

AUZ009E  ISPF error: description

Explanation:  You have made an ISPF error as described 
in the message.

User Response:  Correct the error. 

AUZ010E  Error running script

Explanation:  No results file was found after script has 
been run.

User Response:  Ensure you have specified the correct 
path to the script or that the script is in the appropriate 
directory. Correct the error and rerun. 

AUZ011E  Can’t open the file from HFS

Explanation:  You may have insufficient authority to 
create the file or possibly your disk is full.

User Response:  Review your permissions with your 
systems programmer. 

AUZ012I  Project was built successfully

Explanation:  The project has been built successfully.

User Response:  No response is required. 

AUZ013I  Project was created successfully

Explanation:  The project has been created successfully.

User Response:  No response is required. 

AUZ014E  Tag "library" not found in language 
definition

Explanation:  When building a language definition using 
ISPF panels for data entry, you have not included a 
library name.

User Response:  Return to the language definition panels 
and fill in the required field.

AUZ015E  Tag "member" not found in language 
definition

Explanation:  When building a language definition using 
ISPF panels for data entry, you have not included a 
member name.

User Response:  Return to the language definition panels 
and fill in the required field.

AUZ016E  An unrecognized error occurred

Explanation:  An error occurred that  SCLM Suite 
Administrator Workbench cannot identify.

User Response:  Contact your site’s support personnel.

AUZ017E  Can’t parse the project

Explanation:  An error occurred that prevents SCLM 
Suite Administrator Workbench from parsing the project. 

User Response:  Correct the error and try again to parse 
the project.

AUZ018E  Project already exists

Explanation:  You are attempting to create a project 
having the same name as a project that already exists.

User Response:  If the project name you entered is 
correct, display the Project List and continue to work on 
the project in question.  If you meant to create a new 
project, select another name for it.

AUZ019E  Wrong command

Explanation:  You have entered a command that is not 
available for use on this panel.  Refer to the panel for 
those commands that are acceptable.

User Response:  Correct the error and retry.

AUZ020E  Invalid value.  Type Data Set wild 
card.

Explanation:  A value you have entered for the data set 
name is invalid.  Type a wild card in the field to see a list 
of available data sets.  Remember that you must supply at 
least one qualifier with the wild card.

User Response:  Correct the error and retry.

AUZ021E  Source Types not defined

Explanation:  You have not provided values for required 
parameters of the Types you selected to include in your 
project.

User Response:  Correct the error and retry.
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AUZ022E  Data Set or Member not defined

Explanation:  The data set or member is not defined.

User Response:  Correct the error and retry.

AUZ023E  Group Name not defined

Explanation:  You are attempting to use a Group that you 
have not previously defined.

User Response:  Correct the error and retry.   If you 
misspelled the name of the Group, reenter the Group 
name.  If you meant to enter the Group name you 
specified, return to the Groups panel and define this 
group before proceeding. 

AUZ024E  Type Name not defined

Explanation:  You are attempting to use a Type that you 
have not previously defined.

User Response:  Correct the error and retry.   If you 
misspelled the name of the Type, reenter the  name.  If 
you meant to enter the Type name you specified, return 
to the Types panel and define this Type before 
proceeding. 

AUZ025E  Alternate Control Information not 
defined

Explanation:  You have not defined the identifier for the 
alternate control data sets for this project.

User Response:  Correct the error and retry.  

AUZ026E  Primary Accounting Data Set not 
defined

Explanation:  You have not defined the required Primary 
Accounting data set for this project.

User Response:  Correct the error and retry.  

AUZ027E  JCL Data Set not found in project 
XML

Explanation:  There was no JCL data set in the project’s 
generated XML.

User Response:  Define this data set using the Default 
Data Sets panel.  

AUZ030E  Group into which to migrate 
members not defined

Explanation:  You have specified that members are to be 
migrated into a group which you have not yet defined.

User Response:   Define the required group.

AUZ031E  Group into which to migrate 
members not defined

Explanation:  You have specified that members are to be 
migrated into a group which you have not yet defined.

User Response:   Define the required group.

AUZ032E  Language not defined

Explanation:  A language definition is required for the 
project

User Response:   Create the required language definition.

AUZ033E  Authorization code not defined

Explanation:  An authorization code required for the 
project is not defined.

User Response:  Define the required authorization code.

AUZ034E  Change code not defined

Explanation:  A change code required for the project is 
not defined.

User Response:  Define the required change code.

AUZ035E  Mode not defined

Explanation:  The processing mode is not defined.

User Response:  Define the required mode.

AUZ036E  Group not defined

Explanation:  You are referring to a group that is not 
defined.

User Response:  Define the required group.

AUZ037E  Type not defined

Explanation:  You are referring to a Type that is not 
defined.

User Response:  Define the required Type.

AUZ039E  Group groupname  is not defined in the 
project

Explanation:  You are referring to a group that is not 
defined.

User Response:  Define the required group.

AUZ040E  User exit module name not defined 

Explanation:  You have not defined the required field 
called Module Name for this exit.
 Appendix A.   Messages and Codes  85



 

User Response:  Define the user exit module name.

AUZ042E  Exit Invocation Method not defined 

Explanation:  You have not defined the required field 
Invocation Method.

User Response:  Define the exit invocation method.

AUZ043E  Cannot delete VSAM task from 
skeleton.

Explanation:  You can delete only customized tasks from 
the list, but not predefined tasks.

User Response:  Ensure the task you are attempting to 
delete is a customized task.

AUZ044I  VSAM task taskname successfully 
deleted

Explanation:  Confirmation message that a VSAM task 
you wanted to delete has been deleted.

User Response:  No user action is required.

AUZ045E  Cannot create Architecture Definition

Explanation:  The architecture definition you were 
attempting to create could not be created.

User Response:  Check the log for more information 
about the error or contact your site’s support personnel.

AUZ046E  Cannot create Architecture Definition 
from JCL

Explanation:  The architecture definition you were 
attempting to create could not be created.

User Response:  Check the log for more information 
about the error.

AUZ047E  Cannot complete the migration

Explanation:  The migration of assets into your project 
could not be completed.

User Response:  Check the log for more information 
about the error or contact your site’s support personnel.

AUZ048E  Temporary Archdef file does not exist

Explanation:  The architecture definition files you 
referred to do not exist.

User Response:  Contact your site’s support personnel.

AUZ050E  File tailoring open returned a file 
tailoring already in progress 
condition

Explanation:  The file to be tailored could not be opened 
because tailoring was already in progress.

User Response:  Review the ISPF User’s Guides for 
information about this issue.

AUZ051E  File tailoring open returned the 
output file already in use condition

Explanation:  File tailoring could not progress because 
the output file was already open and in use.

User Response:  Review the ISPF User’s Guides for 
information about this issue.

AUZ052E  File tailoring open returned the 
skeletal file or output file not 
allocated condition

Explanation:  File tailoring could not progress because 
the required skeleton or output file was not allocated.

User Response:  Allocate the required file.  Review the 
ISPF User’s Guides for information about this issue.

AUZ053E  File tailoring open returned a severe 
error condition

Explanation:  File tailoring could not progress.

User Response:  Contact your site’s support personnel.

AUZ054E  File tailoring open returned an 
unknown code

Explanation:  File tailoring could not progress. 

User Response:  Contact your site’s support personnel.

AUZ055E  File tailoring  close returned a file not 
open condition -- severe error

Explanation:  File tailoring could not progress.

User Response:  Contact your site’s support personnel.

AUZ056E  File tailoring  close returned an 
output file in use condition

Explanation:  The file which you are attempting to close 
is in use.

User Response:  Review the ISPF User’s Guides for 
information about this issue and retry.
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AUZ057E  File tailoring close  returned the 
skeletal file or output file not 
allocated condition

Explanation:  The skeleton file or output file is not 
allocated.

User Response:  Review the ISPF User’s Guides for 
information about this issue.

AUZ058E  File tailoring close returned a severe 
error

Explanation:  File tailoring could not progress.

User Response:  Contact your site’s support personnel.

AUZ059E  File tailoring  close returned an 
unknown code -- severe error

Explanation:  File tailoring could not progress. 

User Response:  Contact your site’s support personnel.

AUZ060E  File tailoring  close returned an 
output member exists in the output 
library and NOREPL was specified

Explanation:  An output member of this name already 
exists and you have specified that it should not be 
replaced. 

User Response:  Verify that you do not want to replace 
the output member currently in the output library and 
consider whether NOREPL is what you want to specify.  
Alternatively, determine whether the name of the current 
output file is correct..

AUZ061E  File tailoring  include returned a 
skeleton does not exist condition

Explanation:  File tailoring could not progress because 
the skeleton file to be included does not exist.

User Response:  Review the ISPF User’s Guides for 
information about this issue.

AUZ062E  File tailoring  include returned a 
skeleton in use ---ENQ failed 
condition

Explanation:  File tailoring could not progress because 
the skeleton file to be included was in use by another 
program. 

User Response:  Review the ISPF User’s Guides for 
information about this issue.

AUZ063E  File tailoring  include returned a data 
truncation or skeleton library or 
output file not allocated condition.

Explanation:  File tailoring could not progress. 

User Response:  Review the ISPF User’s Guides for 
information about this issue.

AUZ064E  File tailoring  include returned a 
severe error condition

Explanation:  File tailoring could not progress. 

User Response:  Review the ISPF User’s Guides for 
information about this issue.

AUZ065E  File tailoring  include returned an 
unknown condition --  severe error 

Explanation:  File tailoring could not progress. 

User Response:  Contact your site’s support personnel.

AUZ066E  Allocation Error -- An error was 
encountered allocating the ISPFILE 
DD -- Process not completed

Explanation:    The program cannot read or allocate the 
ISPFILE data set.

User Response:  Contact your site’s support personnel.

AUZ067E  Allocation Error -- An error was 
encountered reading the ISPFILE DD 
-- Process not completed

Explanation:  The program cannot read or allocate the 
ISPFILE data set. 

User Response:  Contact your site’s support personnel.

AUZ070E  Cannot resolve the DSN mask

Explanation:   The product cannot resolve a DSN mask 
error. 

User Response:  Contact your site’s support personnel.

AUZ071E  Cannot open a result file

Explanation:  No results file was found after script has 
been run.

User Response:  Ensure you have specified the correct 
path to the script or that the script is in the appropriate 
directory. Correct the error and rerun. 
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AUZ072E  Cannot get list of Architecture 
Definitions

Explanation:   An error occurred when running the 
script.

User Response:  Check the log for more information 
about the error.

AUZ073E  Cannot delete Project projectname

Explanation:   An error occurred when running the 
script.

User Response:  Check the log for more information 
about the error.               

AUZ074I  Project projectname successfully 
deleted

Explanation:   SCLM Suite Administrator Workbench 
successfully deleted the named project.

User Response:  No user action is required.

AUZ075I  Project projectname successfully 
deleted

Explanation:   SCLM Suite Administrator Workbench 
successfully deleted the named project.

User Response:  No user action is required.

AUZ076E  Cannot clone Project projectname

Explanation:   SCLM Suite Administrator Workbench is 
unable to clone the named project.

User Response:  Check the log for more information 
about the error.

AUZ077E  Cannot get list of projects

Explanation:   An error occurred when running the 
script.

User Response:  Check the log for more information 
about the error.               

AUZ078E  Cannot run VSAM task

Explanation:   An error occurred when running the 
script.

User Response:  Check the log for more information 
about the error.               

AUZ079E  Cannot get list of VSAM tasks

Explanation:   An error occurred when running the 
script.

User Response:  Check the log for more information 
about the error.               

AUZ080E  Cannot create XML from existing 
project

Explanation:   An error occurred when running the 
script.

User Response:  Check the log for more information 
about the error.               

AUZ081E  Cannot create LDML from language 
definition source

Explanation:   An error occurred when running the 
script.

User Response:  Check the log for more information 
about the error.               

AUZ082E  Cannot  create source of Language 
Definition from LDML

Explanation:   An error occurred when running the 
script.

User Response:  Check the log for more information 
about the error.               

AUZ083E  Cannot create language definition 
from JCL

Explanation:   An error occurred when running the 
script.

User Response:  Check the log for more information 
about the error.               

AUZ084E  Cannot Build Project

Explanation:   An error occurred when running the 
script.

User Response:  Check the log for more information 
about the error.               

AUZ085E  Cannot Create Project

Explanation:   An error occurred when running the 
script.

User Response:  Check the log for more information 
about the error.               

AUZ086I  No projects match filter filter 

Explanation:  There are no projects in the Project List that 
match the filter you have specified

User Response:  To obtain a list of other projects, specify 
a different filter.  Otherwise, no user action is required.
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AUZ087E  Group groupname is not low level 
group of project 

Explanation:  The named group is not at the lowest level 
of the project hierarchy.  Architecture definition is 
allowed only for low level groups.

User Response:  Correct the problem.

AUZ088E  Type typename is not defined in the 
project

Explanation:  The named Type has not been defined in 
the project.  You can define this Type on the Types panel.

User Response:  Define the Type before attempting to 
build the architecture definition.

AUZ089E  Type typename  has wrong attributes

Explanation:  The named Type has been defined with 
incorrect attributes for the Type.

User Response:  Respecify the attributes for this Type. 
An architecture definition can be created only for types 
having RECFM=FB and LRECL=80.

AUZ090E  RECFM is not defined

Explanation:  You have not defined this record format

User Response:  Define the record format.

AUZ091E  BLKSIZE is not defined

Explanation:  You have not defined this block size

User Response:  Define the block size.

AUZ092E  LRECL is not defined

Explanation:  You have not defined this logical record 
length.

User Response:  Define the logical record length.

AUZ093E  Type Name is not valid

Explanation:  The name you have assigned to this Type is 
not valid for this Type

User Response:  Respecify the Type name.

AUZ094E  RECFM is not valid

Explanation:  The record format you have assigned to 
this Type is not valid for this Type

User Response:  Respecify the record format.

AUZ095E  BLKSIZE is not valid

Explanation:  The block size you have assigned to this 
Type is not valid for this Type

User Response:  Respecify the block size.

AUZ096E  LRECL is not valid

Explanation:  The logical record length you have 
assigned to this Type is not valid for this Type

User Response:  Respecify the logical record length.

AUZ097E  Type Name is not valid

Explanation:  The name you have assigned to this Type is 
not valid for this Type

User Response:  Respecify the Type name.

AUZ098E  Alternate Name of typename  Type is 
not valid

Explanation:  The alternate name you have assigned to 
this Type is not valid..

User Response:  Respecify the Alternate Type name.

AUZ099E  No of Members of typename  Type is 
not valid

Explanation:  The value you have specified for the 
Number of Members field for this Type is not valid..

User Response:  Respecify the Number of Members.

AUZ100E  Average Number of Records of 
typename  Type is not valid

Explanation:  The value you have specified for the 
Average Number of Records field for this Type is not 
valid..

User Response:  Respecify the Average Number of 
Records.

AUZ101E  At least one group and one type 
should exist in the project to build it 
successfully

Explanation:  To build a project, you must have defined 
at least one group and one Type for it.

User Response:  Add a group, Type, or both to the project 
if necessary.

AUZ102E  Number of members of typename  
Type  not defined

Explanation:  The Number of Members parameter for 
this Type is not defined..
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User Response:  Define the Number of Members 
parameter.

AUZ103E  Average Number of Records of 
typename  Type  not defined

Explanation:  The Average Number of Records 
parameter for this Type is not defined..

User Response:  Define the Average Number of Records 
parameter.

AUZ104E  Package Backup condition of typename  
Type  not defined

Explanation:  The Package Backup parameter for this 
Type is not defined..

User Response:  Define the Package Backup parameter.

AUZ105E  Flags Pack file condition of typename  
Type  not defined

Explanation:  The Flags Pack file parameter for this Type 
is not defined..

User Response:  Define the Flags Pack file parameter.

AUZ106E  Backout Isapack condition of typename  
Type  not defined

Explanation:  The Backout Isapack parameter for this 
Type is not defined..

User Response:  Define the Backout Isapack parameter.

AUZ107E  Backout Isapack condition of typename  
Type  is not valid

Explanation:  The Backout Isapack parameter for this 
Type is not valid..

User Response:  Respecify the Backout Isapack 
parameter within required limits. .

AUZ108E  Package Backup condition of typename  
Type  is not valid

Explanation:  The Package Backup parameter for this 
Type is not valid.

User Response:  Respecify the Package Backout 
parameter within required limits. 

AUZ109E  Flags Pack file condition of typename  
Type  is not valid

Explanation:  The Flags Pack file parameter for this Type 
is not valid.

User Response:  Respecify the Flags Pack file parameter 
within required limits. 

AUZ110E  Reuse limits of typename  Type  not 
defined

Explanation:  The Reuse Limits parameter for this Type is 
not defined..

User Response:  Define the Reuse Limits parameter.

AUZ111E  Reuse Limits condition of typename  
Type  is not valid

Explanation:  The Reuse Limits parameter for this Type is 
not valid.

User Response:  Respecify the Reuse Limits parameter 
within required limits. .

AUZ112E  The topmost group already exists in 
the project

Explanation:  You have already defined this group as the 
topmost group within this project

User Response:  Redefine this group.

AUZ113E  Project must have the only topmost 
group

Explanation:  Only one group can not have a promotion 
group.  That is the group at the top of the tree.

User Response:  Ensure that only one group does not 
have a promote group, and that that group is at the top of 
the tree.

AUZ114E  Promote group must exist

Explanation:  You must define a group as a promote 
group in this project

User Response:  Define a group in this project as the 
promoter group

AUZ115E  The group with the same name 
already exists in the project

Explanation:  You have defined two groups in the project 
with the same name..

User Response:  Rename one of the groups.

AUZ116E  The topmost group should be the key

Explanation:  You have not specified the Key parameter 
for the topmost group in your hierarchy.

User Response:  Specify the topmost group in your 
project hierarchy as the key group.
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AUZ117E  Development group groupname should 
be the key

Explanation:  The group named in the message should be 
the key group.

User Response:  Redefine this group to be the key group.

AUZ118E  You have a loop in promotions for 
group groupname

Explanation:  When defining promotion from group to 
group, there can be no loops. You cannot define a 
promote sequence that has group A promoting to group 
B which in turn promotes back to group A. 

User Response:  Redefine your Promote sequence.

AUZ119E  An FLMALTC macro must have at 
least one FLMGROUP ALTC  
parameter pointing to it

Explanation:  When defining an alternate control group, 
you must ensure that each occurrence of an FLMALTC 
macro has at least one ALTC parameter on an 
FLMGROUP (group definition) macro pointing to it.

User Response:  Redefine a group definition macro to 
point to the alternate control group.

AUZ120E  FLMCTRL macros can only use 
@@FLMPRJ, @@FLMGRP, 
@@FLMTYP in the DSNAME parm.  
If it is specified, DSNAME must 
include @@FLMTYP.

Explanation:  When defining control data sets, the 
DSNAME parameter can use only the variables 
@@FLMPRJ, @@FLMGRP, @@FLMTYP .

User Response:  Redefine the FLMCTRL  macro.

AUZ121E  FLMALTC macros can only use 
@@FLMPRJ, @@FLMGRP, 
@@FLMTYP in the DSNAME parm.  
If it is specified, DSNAME must 
include @@FLMTYP.

Explanation:  When defining control data sets, the 
DSNAME parameter can use only the variables 
@@FLMPRJ, @@FLMGRP, @@FLMTYP .

User Response:  Redefine the FLMALTC  macro.

AUZ122E  FLMCTRL macros can only use 
@@FLMPRJ, @@FLMGRP, 
@@FLMUID in the EXPACCT parm.

Explanation:  When defining control data sets, the 
EXPACCT parameter can use only the variables 
@@FLMPRJ, @@FLMGRP, @@FLMUID .

User Response:  Redefine the FLMCTRL  macro.

AUZ123E  FLMALTC macros can only use 
@@FLMPRJ, @@FLMGRP, 
@@FLMUID in the EXPACCT parm.

Explanation:  When defining control data sets, the 
EXPACCT  parameter can use only the variables 
@@FLMPRJ, @@FLMGRP, @@FLMUID.

User Response:  Redefine the FLMALTC  macro.

AUZ124E  FLMCTRL macros can only use 
@@FLMPRJ, @@FLMGRP, 
@@FLMTYP,  @@FLMDSN in the 
VERPDS parm.  If @@FLMDSN is 
used,  it must be specified in the first 
8 characters.

Explanation:  When defining control data sets, the 
VERPDS parameter can use only the variables 
@@FLMPRJ, @@FLMGRP, @@FLMTYP  and 
@@FLMDSN.

User Response:  Redefine the FLMCTRL  macro.

AUZ125E  FLMALTC macros can only use 
@@FLMPRJ, @@FLMGRP, 
@@FLMTYP, @@FLMDSN in the 
VERPDS parm.  If @@FLMDSN is 
used,  it must be specified in the first 
8 characters.

Explanation:  When defining alternate control data sets, 
the VERPDS parameter can use only the variables 
@@FLMPRJ, @@FLMGRP, @@FLMTYP  and 
@@FLMDSN.

User Response:  Redefine the FLMALTC  macro.

AUZ126E  FLMCTRL macros cannot  use SCLM 
variables in ACCT and ACCT2 parms.

Explanation:  When defining control data sets, SCLM 
variables cannot be used when defining ACCT and 
ACCT2 parameters.

User Response:  Redefine the FLMCTRL  macro.

AUZ127E  FLMALTC macros  cannot  use SCLM 
variables in ACCT and ACCT2 parms.

Explanation:  When defining alternate control data sets, 
SCLM variables cannot be used when defining ACCT 
and ACCT2 parameters.

User Response:  Redefine the FLMALTC  macro.

AUZ128E  FLMCTRL macros cannot  use SCLM 
variables in VERS and VERS2 parms.

Explanation:  When defining control data sets, SCLM 
variables cannot be used when defining VERS and 
VERS2 parameters.
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User Response:  Redefine the FLMCTRL  macro.

AUZ129E  FLMALTC macros  cannot  use SCLM 
variables in VERS and VERS2 parms.

Explanation:  When defining alternate control data sets, 
SCLM variables cannot be used when defining VERS and 
VERS2 parameters.

User Response:  Redefine the FLMALTC  macro.

AUZ130E  If PACKFILE=Y then typename should 
have RECFM=FB and LRECL=130

Explanation:  If the specification of the PACKFILE 
parameter is Yes, then the named Type should have a 
record format of fixed block and a logical record length of 
130.

User Response:  Respecify values for the named Type.

AUZ131E  If  RECFM=U, LRECL must be 0

Explanation:  If the record format is unblocked, logical 
record length must be 0.

User Response:  Respecify the values.

AUZ132E  If  RECFM=U,  BLKSIZE must not be 
0 or <= 32760

Explanation:  If the record format is unblocked, block 
size must not be 0 and must be less than or equal to 
32760.

User Response:  Respecify the values.

AUZ133E  If  RECFM=VBx,  LRECL must not be 
0 

Explanation:  If the record format is variable blocked, 
logical record length must not be 0.

User Response:  Respecify the values.

AUZ134E  If  RECFM=VBx,  BLKSIZE must be 0 
or >= LRECL +4 and <= 32760

Explanation:  If the record format is variable blocked, 
block size must either be 0 or must be greater than or 
equal to logical record length plus 4 and less than or 
equal to 32760.

User Response:  Respecify the values.

AUZ135E  If  RECFM=FBx,  LRECL must not be 
0

Explanation:  If the record format is fixed block, logical 
record length  must not be 0.

User Response:  Respecify the values.

AUZ136E  If  RECFM=FBx,  BLKSIZE must be 0 
or an exact multiple of LRECL and <= 
32760

Explanation:  If the record format is fixed blocked, block 
size must either be 0 or must be an exact multiple of the  
logical record length and less than or equal to 32760.

User Response:  Respecify the values.

AUZ137I  Project projectname successfully parsed

Explanation:  The project whose name appears in the 
message has been successfully parsed --XML has been 
generated for this project.

User Response:  No action is required.

AUZ138E  Authorization group authgroup_name   
has authorization code loop.

Explanation:  An example of a loop that must be avoided 
is the case where authorization group AGRP1 contains 
authorization codes A, B, C, AGRP2, and authorization 
group AGRP2 contains authorization codes A, B, D, 
AGRP1. This specification is invalid.

User Response:  Correct the authorization group 
specification.

AUZ139E  Authorization code loop exists.

Explanation:  An example of a loop that must be avoided 
is the case where authorization group AGRP1 contains 
authorization codes A, B, C, AGRP2, and authorization 
group AGRP2 contains authorization codes A, B, D, 
AGRP1. This specification is invalid.

User Response:  Correct the authorization code 
specification.

AUZ140E  DASD unit not defined

Explanation:  You have not specified a DASD unit.

User Response:  Define the DASD unit.

AUZ141E  DASD unit invalid value

Explanation:  The DASD unit specification you entered is 
invalid..

User Response:  Correct the  specification.

AUZ142E  VIO unit not defined

Explanation:  You have not specified a Virtual 
Input/Output (VIO) unit.

User Response:  Define the VIO unit.
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AUZ143E  VIO unit invalid value

Explanation:  The VIO unit specification you entered is 
invalid..

User Response:  Correct the  specification.

AUZ144E  Max VIO Records not defined

Explanation:  You have not specified the maximum 
number of  records permitted for VIO allocation.

User Response:  Define the parameter Max VIO Records.

AUZ145E  Max VIO Records invalid value -- 
must be numeric

Explanation:  The specification you entered for Max VIO 
Records is invalid. Ensure the value is numeric.

User Response:  Correct the  specification.

AUZ146E  Max lines per report page  not defined

Explanation:  You have not specified the maximum 
number of lines to be written to a report page.

User Response:  Define the parameter Max Lines per 
Report Page.

AUZ147E  Max lines per report page  invalid 
value -- must be numeric

Explanation:  The specification you entered for Max lines 
per report page is invalid. Ensure the value is numeric.

User Response:  Correct the  specification.

AUZ148E  Max lines  per report page  should be 
greater than or equal to 35

Explanation:  The specification you entered for Max lines 
per report page should be greater than or equal to 35.

User Response:  Correct the  specification.

AUZ149E  Promotion group promote_groupname 
for group groupname  must exist

Explanation:  The named promote group does not exist.

User Response:  Define the missing promote group.

AUZ150E  The Type typename wasn’t used in 
Group-Type combination

Explanation:  You have not used the named Type in any 
Group/Type combination.

User Response:  Respecify the Group/Type if necessary.

AUZ151E  The Group groupname wasn’t used in 
Group-Type combination

Explanation:  You have not used the named Group in any 
Group/Type combination.

User Response:  Respecify the Group/Type if necessary.

AUZ152E  The Type typename is not defined in 
the project

Explanation:  You have not defined the named Type for 
this project.

User Response:  Respecify or select the Type if necessary.

AUZ153E  The Group groupname is not defined 
in the project

Explanation:  You have not defined the named group for 
this project.

User Response:  Respecify or select the group if 
necessary.

AUZ154E  A member with the same name 
already exists

Explanation:  You are attempting to define a new 
member having the same name as an existing member.

User Response:  Correct the error.

AUZ155E  Invalid Script Log File

Explanation:  A script was not running at the time the 
error occurred, resulting in an invalid script log file.

User Response:  No action is required.

AUZ156E  Invalid Script Result File

Explanation:  A script was not running at the time the 
error occurred, resulting in an invalid script results file.

User Response:  No action is required.

AUZ157E  Invalid unit selection

Explanation:  You have selected a DASD unit that is not 
available or not valid.

User Response:  Correct the error.

AUZ158E  Allocation Units is not defined

Explanation:  You have not specified the allocation unit 
to be used; for example, tracks, blocks, or cylinders.

User Response:  Correct the error.
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AUZ159E  Initial Allocation is not defined

Explanation:  You have not specified the value to be used 
for the initial allocation.

User Response:  Correct the error.

AUZ160E  Must be numeric

Explanation:  You are attempting to enter a non-numeric 
value in a field that must be numeric.

User Response:  Correct the error.

AUZ161E  Value out of range

Explanation:  The value you have entered in this field is 
either too small or too large.

User Response:  Correct the error.

AUZ162E  Secondary Allocation is not defined

Explanation:  You have not specified the value to be used 
for the secondary allocation.

User Response:  Correct the error.

AUZ163E  Audit Data Set must be selected

Explanation:  Selecting an Auditing Data Set is 
mandatory based on your other selections on this panel

User Response:  Correct the error.

AUZ164E  Number of versions is not defined

Explanation:  You have specified versioning is to be 
active but have not specified the number of versions to be 
retained.

User Response:  Correct the error.

AUZ165I  Migrate completed successfully

Explanation:  You have successfully migrated assets into 
your project.

User Response:  No user action is required.

AUZ166I  Architecture Definition was created 
successfully

Explanation:  You have successfully created an 
architecture definition.

User Response:  No user action is required.

AUZ167E  Cannot run script

Explanation:  The script you required to be run failed to 
run.

User Response:  Contact your site’s support personnel.

AUZ168E  Error code error code was returned.

Explanation:  An unknown error has occurred.

User Response:  Review the output and the error log or 
Contact your site’s support personnel.

AUZ170E  Error occurred

Explanation:  An unknown error has occurred.

User Response:  Review the output and the error log or 
Contact your site’s support personnel.

AUZ171E  The Type with the same name is 
already defined

Explanation:  You are attempting to define a new Type 
having the same name as a Type that is already defined.

User Response:  Rename the Type you are defining.

AUZ172E  SCLM Output Type not defined.

Explanation:  You have not provided the required 
parameter definitions for the Output Type.

User Response:  From the Default Types panel or 
Selected Types panel, provide any missing information 
for the Output Type.

AUZ173E  SCLM List Type not defined.

Explanation:  You have not provided the required 
parameter definitions for the List Type.

User Response:  From the Default Types panel or 
Selected Types panel, provide any missing information 
for the List Type.

AUZ174E  Architecture Definition Language 
languageisn’t defined in project

Explanation:  You are attempting to use an invalid 
language in your architecture definition.

User Response:  Use the Language Definition Wizard to 
define the language you want to use in this Architecture 
Definition.

AUZ175E  Architecture Definition Language not 
defined 

Explanation:  You have left the language definition field 
for this architecture definition empty.
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User Response:  Supply a valid language in your 
architecture definition.

AUZ176E  The Type with the same name already 
exists in the project

Explanation:  You are attempting to move a default Type 
into your project that has  the same name as a Type that is 
already defined in the project.

User Response:  Determine whether you are moving a 
duplicate default Type into the project and decide 
whether to do so.  Alternatively, rename the Type you 
have selected.

AUZ1000E  No contributions found for this 
action.

Explanation:  Internal error

User Response:  Contact your site’s support personnel.

AUZ1001E  Cannot instantiate a Menu Action 
class: description

Explanation:  An internal error has occurred and is 
described to you.

User Response:  Contact your site’s support personnel.

AUZ1002E  Error detected in location

Explanation:  An internal error has occurred at the 
location specified in the message.

User Response:  Contact your site’s support personnel.

AUZ1003E  EAC exception: message

Explanation:  The Enhanced Access Control for SCLM 
exception indicated by the message text of this message 
has occurred.

User Response:  Contact your site’s support personnel.

AUZ1004E       Default EAC Rule File not found.

Explanation:  You must specify a default rule file.

User Response:  Go to the Window pulldown, select 
Preferences > EAC Manager, and specify a default rule 
file.

AUZ1005E  Connection timed out.  Host processes 
may still be active.

Explanation:  A command or file transfer operation has 
not completed within a reasonable time and the 
workstation program has stopped waiting. Host-side 

processes may still be running on behalf of the request 
and were not cancelled.

User Response:  Verify the status of the operation before 
initiating further work on the project.

AUZ1006E  message

Explanation:  An internal error as described in the 
message has occurred.

User Response:  Contact your site’s support personnel.

AUZ1007W       Only a simple filter can be used for 
the project filter - for example, CCC*

Explanation:  When you are defining a filter to be used to 
filter the project list that will be displayed to you at the 
workstation, you may not specify a complex filter; that is, 
a filter with more than one term.

User Response:  Reformulate your filter to have only one 
term.

AUZ1008E       Error obtaining command results

Explanation:  An I/O error occurred getting results back 
from the host system. 

User Response:  Retry. If the error reoccurs, call your 
Support personnel.

AUZ1009E       Error: RSE temp files project not 
found

Explanation:  SCLM Suite Administrator Workbench 
depends on the RSE subsystem to establish a project for 
temp files (RemoteSystemTempFiles).

User Response:  Contact your support personnel.

AUZ1010E       Not connected to mainframe yet.

Explanation:  While trying to create a folder in RSE 
RemoteSystemTempFiles project, the MVS userid could 
not be resolved since the user is not connected to the 
mainframe.

User Response:  Ensure you are connected to the host 
and retry.

AUZ1011E       Error: Can’t create AUZ temporary 
folder.

Explanation:  While trying to create a temporary folder in 
RSE RemoteSystemTempFiles project, an error occurred.

User Response:  Ensure you have required permissions 
or call your support personnel.
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AUZ1012E       Only one active EAC rule data set 
allowed per system. Please remove 
existing mapping and retry.

Explanation:  Indicates that you have selected a system  
to add a rule file to that already has an EAC rule file 
associated with it in EAC Manager preferences.

User Response:  To associate the system with the given 
EAC rule file, set the System name back to <Select> 
status, then choose another system.

AUZ1013E       Invalid rule data set name.

Explanation:  The name you have selected for your EAC 
rule file does not follow MVS data set naming 
conventions.

User Response:  Ensure your data set name follows MVS 
data set naming conventions.  Please respecify the data 
set  name.

AUZ5000S      Usage: projectPROJECT DEFINITION 
<name> <alternate> <member> 
<output_file>  <input_file> 
library_pds_1  [library_pds_2-10]  
[trace_level= <trace_level>]

Explanation:  An error has occurred when parsing the 
project.  

System Action:  Parsing of the project terminates.

User Response:  Call IBM technical support.

AUZ5001S      Invalid Markup Language Type  
<markup language type>

Explanation:  An error has occurred when parsing the 
project.  

System Action:  Parsing of the project terminates.

User Response:  Call IBM technical support.

AUZ5002S      Usage:  <filename>COPYBOOK  
<name> <alternate> <member> 
<output_file> nest=<nesting_level> 
library_pds_1  [library_pds_2-10]  
[trace_level= <trace_level>]

Explanation:  An error has occurred when parsing the 
project.  

System Action:  Parsing of the project terminates.

User Response:  Call IBM technical support.

AUZ5003S      Nesting level too large recursive 
copies?

Explanation:  An error has occurred when parsing the 
project.  

System Action:  Parsing of the project terminates.

User Response:  Call IBM technical support.

AUZ5004S      Nesting level  must be specified

Explanation:  An error has occurred when parsing the 
project.  

System Action:  Parsing of the project terminates.

User Response:  Call IBM technical support.

AUZ5005E      Unable to open output file filename, 
errno=error number 

Explanation:  An error has occurred when parsing the 
project.  

System Action:  Parsing of the project terminates.

User Response:  Correct the problem.

AUZ5006E      Unable to open input file filename, 
errno=error number 

Explanation:  An error has occurred when parsing the 
project.  

System Action:  Parsing of the project terminates.

User Response:  Correct the problem.

AUZ5007I      variable message indicating command 
being run to parse copybook

System Action:  The program continues.

User Response:  No action is required.

AUZ5050E      NOT FOUND errno=error number  

Explanation:  An error has occurred when parsing the 
project.  

User Response:  Correct the problem.   A possible  
correction is to correct the default data set specification.

AUZ8100S  Unauthorized to run AUZREACRM

System Action:  Program terminates.

Explanation:  You do not have sufficient authority to run 
this program.

User Response:  Ensure that your RACF authority is 
RACF  SPECIAL

AUZ8101S  Invalid Parameters

System Action:  Program terminates.
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Explanation:  The parameters supplied are invalid.

User Response:  Call IBM Support.

AUZ8102E  Unable to reserve EAC Rule File 
(Exclusive)

Explanation:  The Rule File you specified may be in use 
and cannot be reserved to your use exclusively.

System Action:  Program ignores this request.

User Response:  Retry later.  If problem persists, call IBM 
support.

AUZ8103E  Unable to reserve EAC Rule File 
(Shared)

Explanation:  The Rule File you want to use is 
unavailable.

System Action:  Program ignores this request.

User Response:  Retry later.  If problem persists, call IBM 
support.

AUZ8104S  Unable to  load HSSGDBUF.

Explanation:  HSSGDBUF may not be in the link list or in 
the same library as AUZEACRM.

System Action:  Program ignores this request.

User Response:  Contact your site’s support personnel.

System Programmer Response:  Ensure AHSSGDBUFis 
in LINKLIST or in same library as AUZEACRM.

AUZ8105S  Error obtaining Violation Buffer

Explanation:  The Violation Buffer is unavailable.

System Action:  Program  terminates.

User Response:  Call IBM support.

AUZ8106E  application not found

Explanation:  You have attempted to run an application 
that does not exist or cannot be found.

System Action:  Program ignores this request.

User Response:  Request an application that exists.

AUZ8107S  Unable to open EAC Rule File

Explanation:  You have specified an incorrect or 
nonexistent Rule File.

System Action:  Program ignores this request.

User Response:  Ensure that you specified a correct Rule 
File.
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Appendix B. Accessibility Features of the Workstation 
Component

Accessibility features help users who have a physical disability, such as restricted 
mobility or limited vision, to use software products successfully. This appendix 
describes the most commonly used accessibility features of  SCLM Suite 
Administrator Workbench. The following sections explain how to use these 
accessibility features on the Windows platform.

To review a complete list of the accessibility features supported by the Eclipse 
platform, refer to "Accessibility Features in Eclipse" in the "Concepts" section of the 
WebSphere Studio Workbench User Guide. To access this user’s guide, from SCLM 
Suite Administrator Workbench menu bar, select Help > Help Contents. Select 
Workbench User Guide from the list of topics that is displayed.

Operating SCLM Suite Administrator Workbench by using the keyboard 

SCLM Suite Administrator Workbench allows you to use the keyboard in place of the 
mouse for many functions. The product can be controlled to a large extent using 
keyboard shortcuts. You can use keys or key combinations to perform operations that 
can also be accomplished through mouse actions. You can access menu items  from 
the keyboard. You can review a subset of the keyboard shortcuts available to you 
using the Window > Keyboard Shortcuts dialog.  When using a pulldown menu, the 
keyboard equivalent typically appears to the right of the menu item. Some keyboard 
items also have shortcuts. Typically, the shortcut letter is underlined in the pulldown 
menu item’s command.  

Optionally, you can customize the function of your keyboard.  Information on how to 
do so can be found in the "Concepts" section of the WebSphere Studio Workbench 
User Guide.  Access the User Guide and then search on the term keys. To customize 
your keyboard while using SCLM Suite Administrator Workbench, select Window > 
Preferences > Workbench > Keys.

To navigate through a window or dialog by using the keyboard instead of the mouse, 
use the following keyboard shortcuts: 

   
Table 3. Navigating through a window or dialog using the keyboard 

Action Shortcut

Access the menu bar in a window F10 or Alt+shortcut letter

Activate a menu item in the menu bar  Enter

Cycle to editor Ctrl+F6

Cycle to a view Ctrl+F7

Cycle to a perspective Ctrl+F8

Access controls in a dialog Alt+shortcut letter

Navigate through the menu bar Right arrow, left arrow, down arrow, up 
arrow 

Move to the next set of controls Tab or Ctrl+Tab

Move to the previous set of controls Shift+Tab 
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To perform main tasks in windows by using the keyboard instead of the mouse, use 
the following keyboard shortcuts:

   

Move within tables Tab or right arrow, Shift+Tab or left arrow, 
down arrow, up arrow

Move within trees Up arrow, down arrow

Expand a tree node Right arrow

Collapse a tree node Left arrow

Move within list boxes Up arrow, down arrow 

Move within drop-down list boxes Up arrow, down arrow

Table 4. Keyboard shortcuts for windows

Action Shortcut

Display Help for the field that has the focus F1

Close the active window Ctrl+F4 or Alt+F4

Close all windows Ctrl+Shift+F4

Save Ctrl+S

Save all Ctrl+Shift+S

Properties Alt+Enter

Cut (Does not currently work in every SCLM 
Administration Manager text field.)

Ctrl+X 

Copy (Does not currently work in every 
SCLM Administration Manager text field. 
However, placing the cursor in a text field 
and right-clicking offers the opportunity to 
select Copy from a pop-up menu.)

Ctrl+C

Paste (Does not currently work in every 
SCLM Administration Manager text field. 
However, placing the cursor in a text field 
and right-clicking offers the opportunity to 
select Paste from a pop-up menu.)

Ctrl+V

Select all Ctrl+A

Find/Replace Ctrl+F

Print Ctrl+P

Return to previously displayed window 
(Back)

Alt+left arrow

Move forward to previously displayed 
window (Forward)

Alt+right arrow

Go to last edit location Ctrl+Q

Table 3. Navigating through a window or dialog using the keyboard 

Action Shortcut
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To perform main tasks in dialogs by using the keyboard instead of the mouse, use the 
following keyboard shortcuts:

   

 

Other accessibility features

In addition to the keyboard features described in this section, SCLM Suite 
Administrator Workbench permits the use of the following accessibility features 
provided by the Eclipse platform:

• Screen-reader software and a digital speech synthesizer to hear what is displayed 
on the screen

• Voice recognition software to enter data and to navigate the user interface

• The ability to magnify what is displayed on the screen in the graphical views

• The ability to modify fonts and colors using the Window > Preferences dialog

Search. 
Note that once the pop-up search dialog 
displays, press Shift+Tab to highlight the tabs 
in the search dialog and then the right or left 
arrows to move through the tab set.

Ctrl+H

Table 5. Keyboard shortcuts for dialogs 

Action Shortcut

Confirm a dialog Enter

Cancel a dialog Esc

Activate a button that has the focus Spacebar or Enter

Select and deselect check boxes and radio 
buttons

Spacebar

Navigate forward within a check box and 
radio button group

Tab 

Navigate backward within a check box and 
radio button group

Shift+Tab 

Open drop-down list box menu Alt+down arrow 

Close drop-down list box menu Esc

Move up and down in combination box 
menu

Up arrow, down arrow

Activate drop-down list box menu item Enter

Move within a list box Up arrow, down arrow

Activate a list box entry Enter

Move between the pages of a window 
containing tabs if the tab has the focus

Right arrow, left arrow

Table 4. Keyboard shortcuts for windows

Action Shortcut
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Appendix C. Notices

This information was developed for products and services offered in the U.S.A. IBM 
may not offer the products, services, or features discussed in this document in other 
countries. Consult your local IBM representative for information on the products and 
services currently available in your area. Any reference to an IBM product, program, 
or service is not intended to state or imply that only that IBM product, program, or 
service may be used. Any functionally equivalent product, program, or service that 
does not infringe any IBM intellectual property right may be used instead. However, 
it is the user's responsibility to evaluate and verify the operation of any non-IBM 
product, program, or service.

IBM may have patents or pending patent applications covering subject matter 
described in this document. The furnishing of this document does not give you any 
license to these patents. You can send license inquiries, in writing, to: 

IBM Director of Licensing
IBM Corporation
North Castle Drive
Armonk, NY  10594-1785
U.S.A.

For license inquiries regarding double-byte (DBCS) information, contact the IBM 
Intellectual Property Department in your country or send inquiries, in writing, to: 

IBM World Trade Asia Corporation
Licensing
2-31 Roppongi 3-chome, Minato-ku
Tokyo 106, Japan

The following paragraph does not apply to the United Kingdom or any other 
country where such provisions are inconsistent with local law: INTERNATIONAL 
BUSINESS MACHINES CORPORATION PROVIDES THIS PUBLICATION “AS IS” 
WITHOUT WARRANTY OF ANY KIND, EITHER EXPRESS OR IMPLIED, 
INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF NON-
INFRINGEMENT, MERCHANTABILITY OR FITNESS FOR A PARTICULAR 
PURPOSE. Some states do not allow disclaimer of express or implied warranties in 
certain transactions, therefore, this statement may not apply to you.

This information could include technical inaccuracies or typographical errors. 
Changes are periodically made to the information herein; these changes will be 
incorporated in new editions of the publication. IBM may make improvements 
and/or changes in the product(s) and/or the program(s) described in this publication 
at any time without notice.

Any references in this publication to non-IBM Web sites are provided for convenience 
only and do not in any manner serve as an endorsement of those Web sites. The 
materials at those Web sites are not part of the materials for this IBM product and use 
of those Web sites is as your own risk.

Licensees of this program who want to have information about it for the purpose of 
enabling: (i) the exchange of information between independently created programs 
and other programs (including this one) and (ii) the mutual use of the information 
which has been exchanged, should contact: 

IBM Corporation
J46A/G4
555 Bailey Avenue
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San Jose, CA 95141-1003
U.S.A.

Such information may be available, subject to appropriate terms and conditions, 
including in some cases, payment of a fee.

The licensed program described in this information and all licensed material available 
for it are provided by IBM under terms of the IBM Customer Agreement, IBM 
International Program License Agreement, or any equivalent agreement between us.

Any performance data contained herein was determined in a controlled environment. 
Therefore, the results obtained in other operating environments may vary 
significantly. Some measurements may have been made on development-level 
systems and there is no guarantee that these measurements will be the same on 
generally available systems. Furthermore, some measurement may have been 
estimated through extrapolation. Actual results may vary. Users of this document 
should verify the applicable data for their specific environment.

Information concerning non-IBM products was obtained from the suppliers of those 
products, their published announcements or other publicly available sources. IBM has 
not tested those products and cannot confirm the accuracy of performance, 
compatibility or any other claims related to non-IBM products. Questions on the 
capabilities of non-IBM products should be addressed to the suppliers of those 
products.

All statements regarding IBM's future direction or intent are subject to change or 
withdrawal without notice, and represent goals and objectives only.

All IBM prices shown are IBM's suggested retail prices, are current and are subject to 
change without notice. Dealer prices may vary.

This information is for planning purposes only. The information herein is subject to 
change before the products described become available.

This information contains examples of data and reports used in daily business 
operations. To illustrate them as completely as possible, the examples include the 
names of individuals, companies, brands, and products. All of these names are 
fictitious and any similarity to the names and addresses used by an actual business 
enterprise is entirely coincidental.

COPYRIGHT LICENSE:

This information contains sample application programs in source language, which 
illustrates programming techniques on various operating platforms. You may copy, 
modify, and distribute these sample programs in any form without payment to IBM, 
for the purposes of developing, using, marketing or distributing application 
programs conforming to the application programming interface for the operating 
platform for which the sample programs are written. These examples have not been 
thoroughly tested under all conditions. IBM, therefore, cannot guarantee or imply 
reliability, serviceability, or function of these programs.

If you are viewing this information softcopy, the photographs and color illustrations 
may not appear.

Trademarks

The following terms are trademarks of the IBM Corporation in the United States or 
other countries or both:
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InstallShield is a registered trademark of InstallShield Software Corporation.

Java and all Java-based trademarks are trademarks of Sun Microsystems, Inc. in the 
United States, other countries, or both.

Microsoft, Windows, Windows NT, and the Windows logo are trademarks of 
Microsoft Corporation in the United States, other countries, or both.

UNIX is a registered trademark of The Open Group in the United States and other 
countries.

Other company, product and service names may be trademarks or service marks of 
others.

AIX
IBM
OS/390
RACF
Redbooks
WebSphere
z/OS 
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Bibliography

This bibliography lists the publications for IBM 
products that are related to the SCLM Suite 
Administrator Workbench product, or publications 
that  you may need to consult when using the 
Workbench. For a complete listing of,  and access to, 
all of the books in a particular library, visit the IBM 
web site at www.ibm.com and search for the library 
in question.  Links to some of the libraries cited in 
this bibliography can be found in the Preface to this 
manual.

Software Configuration and 
Library Manager Suite

 The documents in this section are those comprising 
the SCLM library and the libraries of products that 
are part of the SCLM Suite.

• z/OS ISPF  Software Configuration and Library 
Manager: Project Manager’s and Developer’s 
Guide, SC34-4817

• z/OS ISPF  Software Configuration and Library 
Manager: Reference, SC34-4818

• Software Configuration and Library Manager 
Suite Administrator Workbench: User’s Guide,  
SC31-6571

• Software Configuration and Library Manager 
Suite Administrator Workbench: Installation and 
Customization Guide, GC31-6787

• Enhanced Access Control for SCLM for z/OS: 
User’s Guide, SC27-1591

• IBM Breeze for SCLM : User’s Guide, SC31-8820

• IBM Cloud 9 for SCLM : User’s Guide, SC31-
8846

IBM Interactive System 
Productivity Facility (ISPF) for 
z/OS

For information on navigating through ISPF, 
understanding PF key functions, and working in an 
ISPF  session, refer to the following manuals:

• ISPF: User’s Guide, Volume I, SC34-4822

• ISPF: User’s Guide, Volume II, SC34-4823

z/OS TSO/E

The following manuals provide introductory 
information about TSO/E.

• z/OS TSO/E: Primer, SA22-7787

• z/OS TSO/E: User’s Guide, SA22-7794

z/OS UNIX System Services

Use the UNIX System Services documentation to 
understand how UNIX System Services operates 
within the z/OS environment

• z/OS UNIX System Services : User’s Guide, 
SA22-7801

Additional Information

You may also want to refer to some of the IBM 
RedBooks, available online at www.ibm.com.  You 
may find the following useful:

• IBM RedBook: Hierarchical File System Usage 
Guide, SG24-5482
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